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Participants
This course is aimed at:

• Users of EXO Job Costing.

Prerequisites

Basic PC experience is required.

Understanding of EXO Business and procedures.

Instructional method

The instructional method combines trainer-led demonstrations with hands-on student 

practice. You will work through a series of examples. Each unit concludes with a Review 

Task. 

Conventions used in this manual

• Objects such as buttons or icons that you must click or select are shown in bold.

• Information to be entered (typed in) is shown in bold and italics.

• Keyboard keys are shown as , , etc.

Screenshots in this manual are for illustration purposes only and may differ from those in 

the actual product due to configuration settings.
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Symbols used in this manual

Symbol Name This symbol tells you... 

Practice task

Review task

… to complete a task to practice the skills you 

have just learnt, or as a review task at the end 

of the unit to consolidate what you have learnt.

Written Review task … to complete written questions to review the 

content covered in the unit.

Optional Challenge … to complete this task if you have finished 

early and are looking for an extra challenge.

Tip … about helpful tips

Note … to take note of an important message.

Warning … about potential problems to be aware of.

Important … to pay attention to an important notice.

New … where features are new for EXO Job Costing.

Reference … where to go to find more information.
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Skills Checklist … to tick off a list of skills that you have learnt 

during the unit.

Symbol Name This symbol tells you... 
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Overview

The Job Costing module is an additional function set that can be added to the MYOB EXO

Business system. It is an external program that interfaces with the EXO Business core

program.

Job Costing provides a fully integrated solution for businesses using time costing and

billing, businesses who have a high proportion of direct purchases relating to a specific

clients project, and any other business that accumulates charges over a period of time.

Invoicing is made easy. As each job progresses, activities associated with the job are

recorded, for example labour or parts. These accumulated transactions can be

manipulated and formatted to a high degree in order to present an invoice in a view

suitable for the customer, while retaining a true picture of cost and profitability at a

detailed level.

Standard job information options (categories etc) are set up initially and can then be

selected to apply to each job.
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Job Costing Features

The major characteristics of Job Costing:
• Time can be charged out and accounted for on an employee or resource basis for jobs 

taking place over a period of time.

• Purchases can be made and applied directly to a job.

• Work in progress may be a significant proportion of the businesses financial position 

at any time. The costs of this work can be included in financial reports covering the 

period they are incurred.

• Different staff from different departments may be involved in a job and all costs can 

be collated.

• Costs incurred on a job or the description of a job can be amended prior to job being 

finalised and invoiced.

• Comprehensive reports can be created to monitor jobs in progress or analyse 

completed jobs.

• Projects depreciation for the next financial year.

• Generation of necessary formal documentation such as invoices and quotes as well 

as user defined documents.

• Serial numbers of stock items can be tracked from Purchasing through Work In 

Progress and onto Invoicing.

General features of the Job Costing interface, 
common to other MYOB EXO Business modules:

• Menu Designer

• Contacts

• Document Manager

• Clarity reporting tools

• Extra fields (on transaction lines also)

• Custom Buttons
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Job Costing does not fully support the following 
advanced core MYOB EXO Business features:

• Automatic 'processing' of build type BOMs during invoicing

• One-off stock items

• Batch numbers
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Objectives

Upon completion of this course you will be able to:

• Create New Jobs

• Create Quotes

• Enter Timesheets

• Enter Costs

• Enter Purchase Orders

• Generate Invoices

• Attach Documents and History Notes

• Use and Maintain Resource Planning

• Set up Module and Locations

• Set up Job Types, Job Statuses and Job Categories

• Set up Cost Groups and Cost Types

• Set up Job Resources and Job Flags

• Maintain Profile Settings

• Integrate with Payroll

• Use Job Analysis and Reporting
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Navigational & Function Keys

MYOB EXO Business can be navigated by keyboard or mouse, however a combination of 

both is generally used. The standard keyboard convensions for Windows are used, with a 

few MYOB EXO Business-specific options.

Windows Navigation Keys

TAB Moves from field to field, column to column

SHIFT+TAB Moves backwards from field to field, column to 

column

ENTER On open dialogue boxes, automatically select the OK 

button.

ARROW KEYS Moves around a grid, or up and down a list.

PAGE UP, PAGE DOWN Moves between the “sections” of some screens, 

such as moving from the invoice header to the body 

to the end.

ALT + (Underlined Letter) ALT key plus the underlined letter on a field label 

activates that function, e.g. ALT + N within a the 

debtor account screen creates a New Debtor.
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Job Costing Setup

In this unit you will learn 
how to setup Job Costing 
including Job Types, 
Statuses and Cost Types

By the end of this unit, you will be able to:

Install/Upgrade Job Costing

Understand Job Costing Structure

Set-up Job Types, Statuses and Categories

Set-up Cost Types and Groups

Set-up Job Resources

Set-Up Job Flags
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Overview

In order to accommodate the many different ways in which MYOB EXO Job Costing can be 

employed within service and project based businesses, it is necessary to have a 

comprehensive list of preference settings that define and modify the behaviour of Job 

Costing to suit these businesses.

The process of setting up Job Costing, includes the following steps:

• Detailing configuration changes to the MYOB EXO Business system (‘Setting up MYOB 

EXO Business for Job Costing’ on page 3) to prepare for the use of Job Costing.

• Refer to ‘Installing Job Costing’ on page 6 of your Job Costing module

• Providing an overview of the Job Costing structure (‘Analysis Available in MYOB EXO 

Job Costing’ on page 11), including job status and related flags, job types and 

categories, and cost groups and cost types.

• Setting up the Job Costing environment options (‘Job Costing Profile Settings’ on 

page 34) before its initial use, including how to record standard (default) Job Costing 

information such as job types and categories to simplify the task of data entry.

N O T E

A certified MYOB EXO Job Costing implementation partner normally performs the set up. 

This information is provided for completeness, and to help the advanced user's 

understanding of the Job Costing system.
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Setting up MYOB EXO Business 
for Job Costing

The Job Costing module relies on some settings inside MYOB EXO Business for its initial 

installation and set up. Some changes to the EXO Business Configurator are therefore 

required before installing Job Costing.

Set up Periodic/Perpetual Stock Integration

The General Ledger Integration option is set in the Business Essentials > General Ledger 

section of the EXO Business Configurator. An MYOB EXO Business partner should assist in 

this part of the configuration.

Set up a WIP Stock Location

A stock location should be designated as a Work In Progress location. 

To set up a Work In Progress stock location:

1 Open the EXO Business Configurator application (Exocfg.exe) and select the Admin 

tab. The Business Admin menu appears on the left hand side

2 Select Stock > Stock Locations from the Business Admin menu. The Stock Locations 

screen is displayed.

3 If no unused locations are available, click the New button to add a new location. The 

following warning message is displayed:

4 Click Yes. A new location is added to the list.

New Stock Location Warning
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5 Select the unused location and double-click. The Details tab is displayed.

6 Use the following table to complete the fields on the page. 

7 Click the Save button. The new WIP stock location will now be created and added to 

the location list. 

WIP Location Setup

Field Description

Location No The location number. Automatically assigned.

Code The code related to this location, e.g. 'WIP'. 

Name The name of the location, e.g. 'Work In Progress'.

Exclude From Free 

Stock

Select if this location is not to be referenced when computing free 

stock. In this case of WIP this option should be enabled.

Exclude From Sales Select if this location is to be excluded from sales screens. Do not 

allow sales via Sales Orders or normal debtors invoicing from this 

location. This option should be disabled, so that Debtor invoicing is 

possible from Job Costing.

Exclude From 

Valuation

This setting allows stock valuation reports to be written to 

specifically exclude the WIP location. Normally this option is 

enabled for work in progress because its value should be taken 

from Job Costing itself, including the value of labour expended and 

unbilled subcontractors charges.

Job Costing Work In 

Progress Location

This setting allow for a location to locked down as a WIP location for 

committing stock to jobs. When checked, the location will not 

appear in Purchase or Sales Processes. It will only be available in the 

Job Detail Tab and can be changed up to the point of committing 

stock.

Active Select this option to ensure that the location is active; otherwise it 

will not appear in any drop down selection lists on transaction 

screens.
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You now need to instruct Job Costing to use this location.

8 Still in the EXO Business Configurator application, select the Essential tab. The 

Business Essentials menu list appears on the left.

9 Choose EXO Job Costing.

10 Select the location you created above for the WIP Stock location property.
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Installing/Upgrading Job Costing Overview
This section explains how to install or upgrade the Job Costing module. If you need related 

information please contact your EXO Business partner.

N O T E

Running Job Costing for the first time results in the creation of extra fields and tables within 

your EXO Business database. As with any upgrade ensure you have a good back-up of your 

database beforehand.

Ensure EXO Business settings have been set up for use with Job Costing (‘Setting up MYOB 

EXO Business for Job Costing’ on page 3).

N O T E

Job Costing limits the users to 500 transactions in any demonstration system.

Copy the Job Costing application (Jobcost.exe file) into the directory that contains your 

MYOB EXO Business application (Exonet.exe file). 

It is expected that all but the simplest Job Costing implementations will make extensive 

use of use EXO Business Clarity Reporting. Sample reports and business documents are 

provided, but may require customisation before they can be used.

Ensure you have copied the minimum files required for Job Costing:

• JobCost.exe

• Clarity files

Installing Job Costing

Run the MYOB EXO Job Costing application (Jobcost.exe) to launch the Job Costing 

application setup. The login screen appears:

Log in as an Administrator, selecting the database currently used by EXO Business. Click 

OK.

Login Screen
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Job Costing displays a warning box asking you if you want to add this module to this 

database:

Click Yes. The licence dialog appears:

Select the I accept licence agreement radio button then click the Continue button. An 

information box then appears asking you run the EXO Business Configurator (ExoCfg.exe) 

to initialise the database for Job Costing.

Job Costing Add Module

License Agreement

Job Costing Added



© Copyright 2013 MYOB Technology Pty Ltd

Set up and Process EXO Job Costing

 8

Click OK. Job Costing will shut down, awaiting you to run ExoCfg.exe.

Open the EXO Business Configurator application (Exocfg.exe). Login to the Configurator by 

typing the Administrator's user name and Password. Select the same database chosen 

above (the database currently used by EXO Business).

Click OK. This brings up the Database Update screen: 

Ensure the Job Costing module is included in the selection as above. Click the Update 

button. As mentioned earlier, this results in the creation of extra fields and tables within 

your (selected) EXO Business database. The Report screen rolls through these changes.   

Job Costing Update
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The words ’Upgrade Completed’ are displayed once the update is complete. Click the Close 

button. 

Job Costing Updated Completed
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GL Control Accounts
To get the transactions to post to the correct General Ledger accounts, you will have to 

configure the GL Control Accounts in EXO Config. These can be found under Essential > GL 

Control Accounts.

The main three control accounts that have to be set are:

Work In Progress

Work In Progress Stock Cost Variance

Non Stock Write-Offs

These can be added by double clicking on the relevant line. You will then have an option to 

search for a General Ledger code from the list of existing codes in your system. To select 

one, highlight the General Ledger Code and click on Select & Close.

If you do not have a code for the Control Account you will have set one up using the 

instructions in EXO Business Online Help.

I M P O R T A N T

You must have the Control Accounts set up in order for the Stock Integration to work. 

Failure to do this may affect the data integrity of the General Ledger postings.

GL Control Account Setup
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Planning for Job Costing

In order to effectively use Job Costing it is recommended firstly go through a planning 

stage. This will help to determine how the system needs to be configured. In this next 

section we explain how the system is pieced together and show how to match your 

business model with the settings.

Job Costing Analysis
Before installing Job Costing, thought should be put into the Job Costing Analysis Structure 

Chart. This will define how jobs will be structured for analysis.

The highest natural grouping of transactions that exists is time and materials. Costs could 

logically be further broken down into direct purchases and stock. A key to the flexibility of 

the Job Costing lies in the appropriate use of Cost Types (‘Setting Cost Types’ on page 23) 

and Cost Groups (‘Setting Cost Groups’ on page 22).

Clues as to how your business might be broken down into Job Types (‘Set up Job Costing’ 

on page 16), Statuses (‘Setting Job Statuses’ on page 18), Categories (‘Setting Job 

Categories’ on page 20), Cost Groups and Cost Types can be gleaned from the business 

forms that you use in the course of your businesses activity. These include Creditors 

Invoices that you receive, Debtors Invoices you produce, information written on time 

sheets and job cards, etc.

Analysis Available in MYOB EXO Job Costing
The following diagram outlines the analysis available in Job Costing:

Job Costing Analysis Chart
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Breaking Down Business Activities and Processes

Use the following hints to help you analyse and breakdown the business activities and 

processes into MYOB EXO Job Costing terms. A large sheet of A3 Paper or a whiteboard, a 

photocopier and a number of sheets of A3 or A4 paper may be useful.

Job Types and Job Categories

Identify and write down at the top of the sheet the key departments or divisions within 

your company e.g. Servicing Division, Consulting division, Project management Division. 

These may be the Job Types (‘Setting Cost Types’ on page 23).

Under each department heading, list any further divisions e.g. the servicing division may 

undertake warranty service work or time and materials service work. These may be the 

Job Categories (‘Setting Job Categories’ on page 20).

Job Statuses and Job Flags

Under each of the job categories write down every phase of work-flow that a job might go 

through from initial entry through to completion and archival. Organise these into a 

sequence if it isn't already. Consolidate these into a single shared list for all divisions. 

Carefully consider these and give each one a unique short-code letter, e.g. L = Lost Quote 

or S = To Schedule. These represent potential Job Statuses (‘Setting Job Statuses’ on 

page 18).

Collect examples of any relevant documentation associated with each of the above. 

Examples might include; Job Sheets, Quality Control Sheets, Invoices, Stock requirements 

sheets, Quotation forms and so on.

 

Duplicate the following on a multiple sheets of paper and for each Job Status (stage in a 

job's life cycle), and identify key characteristics in terms of the following

These will be useful when keying in the chosen job statuses (covered shortly).

Shortcode Job Status Name

Y or N At this stage we wish to prevent entry of new transactions to this 

job

Y or N At this stage we wish to prevent any changes to this job

Y or N At this stage the job is considered completed

Y or N This stage the Job is considered archived and no longer current 

work

Y or N At this stage we consider the Job to be ready for invoicing

Y or N Jobs at this stage are considered active.

Y or N Jobs at this stage should not allow alterations to the quote or 

budget
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Next to each stage list any significant 'actions', 'tasks' or 'check-points' that you consider 

need to take place, e.g. Check Prices, Quality Check, Order Parts, Pick Parts, Invoice Now 

etc.  These are potential Job Flags (‘Setting Job Flags’ on page 28).

N O T E

Too many job flags make the system cumbersome to operate and they soon fall into disuse. 

Ensure each flag will really be utilised - the fewer flags used the better.

Job Resources

Job Resources (‘Setting Job Resources’ on page 26) can encompass staff plus plant and 

equipment. Staff resources link to the staff table. When Job Costing is installed a resource 

is automatically generated for each existing staff member. Plant items may be manually 

added to the list by creating a resource that does not point at a staff member.

Cost Types and Cost Groups

The Cost Type (‘Setting Cost Types’ on page 23) is the lowest level of analysis and has the 

potential to connect directly to the General Ledger accounts and sub-codes that are set up 

in your chart of accounts. They can be grouped under Cost Groups (‘Setting Cost Groups’ 

on page 22) (mainly for reporting and analysis purposes), although they need not 

necessarily be related in any way to Cost Groups. 

When performing the setup, it makes sense to set up Cost Groups first, as Cost Types can 

be linked to them in a hierarchy. Cost Groups (previously called Secondary Cost Centres in 

older versions of EXO Business) are much simpler in function and are really there for 

report grouping only.

Existing Stock Product Group 1 or General Ledger revenue breakdown (accounts) might 

provide clues to appropriate transaction breakdown summary codes for Cost Groups.

Existing Stock Product Group 2 or General Ledger revenue breakdown (Sub Accounts) 

might provide clues to appropriate transaction breakdown detailed codes for Cost Types.

Cost Types provide a method of defining different types of cost activities that occur during 

the normal process of business, in addition to reporting and analysis. Each Cost Type has 

several user settings associated with it. 

Much emphasis is placed on user defined shortcut keys. They allow rapid keyboard based 

transaction entry and avoidance of search screens once the shortcuts become familiar.

Each Stock Item may also have its own default Cost Type and Cost Group. These defaults 

are used unless overridden at time of entry. To do this you will need select values in the 

Cost Group and Cost Type fields shown on the Extra fields tab of the Stock Item.
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Examples

The following is an example of the resulting setup based on analysis of a typical EXO 

Business Partner's business involved in information technology consultancy and computer 

and network sales and services.

Job Status Job Type Job Category Job Flag (User)

N New Job 1. Bench 1. Normal 1. Build

P Presales 

Technical

2. Booked In Job 2. C.O.B Tomorrow 2. Build Complete

Q Quote 3. Database 3. Service 

Agreement

3. Finance

H Scheduled 4. Help Desk 4. Today 5.00 PM 4. Further Action Rqd

O To Be Invoiced 5. Web Design 5. Tomorrow 9.00 

AM

5. Passed To Sales

B To Be Scheduled 6. Onsite 6. Urgent 6. Purchasing

U Unassigned 7. Outwork 7. Within 1 Week 7. RA

W Work In 

Progress

8. Phone Support 8. Within 24 Hours 8. Ready For Dispatch

T Template 9. Product Supply 9. Within 36 Hours 9. Staff Purchase

X Cancelled 10. Project 10. Within 48 Hours 10. Unassigned

C Completed 11. Recurring Job 11. Waiting On Agent

I Invoiced 12. Remote Support 12. Waiting On Client

L Lost Quote 13. Service 

Agreement

13. Waiting On 

Paperwork

14. Subcontractor 14. Waiting On Parts

15. Technicians 

Hours

16. Unassigned
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Below is another theoretical example from the construction industry:

Job Costing Analysis Example
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Set up Job Costing 

To open MYOB EXO Business Job Costing

1 Select MYOB EXO Job Costing from the MYOB EXO Business section of the Windows 

Start menu to launch the Job Costing application. The EXO Business login window is 

displayed:

2 Enter logon details and click OK. The Job Costing main menu appears. 

N O T E

Once logged in, the Job Costing module may display a warning if you haven't previously set 

the WIP settings (‘Set up a WIP Stock Location’ on page 3).

N O T E

Setting Job Types
A Job Type is the highest level of categorisation of a job. Jobs can be further broken down 

into Job Categories (‘Setting Job Categories’ on page 20), then Cost Groups (‘Setting Cost 

Groups’ on page 22) (optional), then Cost Types (‘Setting Cost Types’ on page 23) 

(optional). 

For example, appropriate Job Types for Motorpartz might be Full Service, Tune, Tyres, 

Brakes and Customisation.

To set up Job Types:

1 Click Setup > Setup Job Types from the Job Costing menu. 

Login Screen
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2 The Setup Job Types screen is displayed.

3 Click New. 

4 Type in the first required Job Type name.

5 Click Save to save data or Cancel to lose all entries made.To add another Job Type, 

click New and repeat the process.

Job Costing Setup Job Types

Job Costing Setup Job Types Detail

Field Description

Job Type No The system assigns a Job Type number on clicking 

save.

Job Type Name A descriptive name for the job type. These could be 

taken from the Job Costing Analysis (‘Job Costing 

Analysis’ on page 11).

Gantt Bar Colour Select the colour to be used for jobs of this type on 

the Job Overview tab (‘Job Overview’ on page 70).
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N O T E

Job Types, Job Categories (‘Setting Job Categories’ on page 20), Cost Groups (‘Setting Cost 

Groups’ on page 22) and Cost Types (‘Setting Cost Types’ on page 23) are given a key 

identity number by the system. This number cannot be directly controlled (except by using 

SQL directly). As an alternative, create say ten in advance, manipulate the list into the order 

desired, and then delete any remainders. Do not delete items once there has been any 

likelihood that jobs have been created using these codes.

Setting Job Statuses
A Job Status is used to indicate the status of a given job. Each one has a number of 

associated characteristics (flag settings) that dictate whether certain system-defined Job 

Flags (‘Setting Job Flags’ on page 28) are raised on changing to this status. Job Statuses are 

a vital part of the configuration of the Job Costing Module.

For example, a job may be at the stage of Quote, New Job, Work In Progress, Finished or 

Cancelled. A job may in fact have two job statuses representing cancelled jobs; those 

which are a desirable job you cancelled as a result of losing a quote to a competitor (Lost 

Quote), and a similar cancelled status that represents when a quotation was withdrawn on 

the basis of the job being undesirable or not suitable work for your company. Both of these 

statuses would have the same characteristics of being non-active jobs, being considered 

Archived, and probably Locked. However it is possible to differentiate between these two 

cancelled statuses on analysis reports. A Job Status applies across all Job Types (‘Set up Job 

Costing’ on page 16).

To set up Job Statuses:

1 Select Setup > Setup Job Statuses from the Job Costing menu. The Setup Job Status 

screen is displayed. There may be a number of job statuses already created. Others 

can be added.

Job Costing Setup Job Statuses
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2 Click New. Type in the details of any further Job Statuses required.

Job Costing Setup Job Statuses Detail

Field Description

Job status key A meaningful one character unique short code to represent this Job 

Status.

Job status name A suitable description of the job status, e.g. Work In Progress.

Prevent new 

transactions

System flag preventing entry of additional transactions to jobs of 

this status.

Make job read only System flag to ensure that no part of the job can be edited while in 

this state. This includes the Status field itself. Only a user who has 

Job administrator rights can modify this job thereafter. By default 

all users have administrator rights.

Jobs are complete System flag to mark jobs in this state as complete

Jobs are archived System flag to identify that jobs in this state are considered 

archived and can be excluded from active lists of jobs.

Jobs are ready to 

be archived

System flag to identify jobs as ready to be invoiced. Invoice Clerks 

should look for these jobs.

Jobs are active System flag to include jobs in this state in any lists of active jobs. 

Default is Yes.

Quotation is read 

only

System flag used to lock the quote tab to prevent further changes 

while the job is in this status. Default is No. The quote tab will be 

locked unless logged in as a user with Job administrator rights.
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3 When the Workflow Constraints Apply option is checked for a given status, you can 

click on the   icon to open a further screen to specify workflow status paths:

4 Check the boxes in the Active column to specify which statuses you can move a job 

to from this status. If you want to record history of the status movement, then check 

the boxes in the Track Event column as well.

Setting Job Categories
A Job Category is the second level of categorisation of a job, under the Job Type (‘Set up 

Job Costing’ on page 16). It can then be further broken down at line level into Cost Groups 

(‘Setting Cost Groups’ on page 22) (optional), then Cost Types (‘Setting Cost Types’ on 

page 23) (optional). 

For example, appropriate Job Categories for the Motorpartz demo database, under a Job 

Type of ’Full Service’, might be ’Oil Change’, ‘Fault Inspection’, ‘Replace Parts’, and 

‘Miscellaneous’. Another common use for Job Category might be to signify’Urgent’ and 

’Non-urgent’ jobs.

To set up Job Categories:

Worflow 

constraints apply

When this flag is set the user may specify which statuses the job 

may move to. The status change can also be flagged to be tracked.

Gantt bar colour Select the colour to be used for jobs of this status on the Job 

Overview tab (‘Setting Job Statuses’ on page 18).

Job Costing Workflow Constraints
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1 Select Setup > Setup Job Categories from the Job Costing menu. The job category 

search screen is displayed.

2 Click New and type in the first required Job Category name.

3 Click Save to save data or Cancel to lose all entries made.

To add another Job Category, click New and repeat this process.

Job Costing Setup Job Categories

Job Costing Setup Job Categories Detail

Field Description

Job Category No The system assigns a Job Category number on clicking Save.

Job Category Name A descriptive name for the Job Category. Descriptions could be 

taken from the Job Costing Analysis (‘Resource Allocation’ on 

page 74).

Short Code A short code to speed entry. Can be up to 3 characters.

Gantt Bar Colour Select the colour to be used for jobs in this category on the Job 

Overview tab (‘Setting Job Categories’ on page 20).



© Copyright 2013 MYOB Technology Pty Ltd

Set up and Process EXO Job Costing

 22

Setting Cost Groups
A Cost Group is used to describe a group of activities that make up a Job Category (‘Setting 

Job Categories’ on page 20). Cost Group is an optional third level of categorisation of a job, 

under Job Type (‘Set up Job Costing’ on page 16) and Job Category. It can then be further 

broken down into Cost Types (‘Setting Cost Types’ on page 23) (optional).

Cost Groups may be set up for some Job Categories but not others, as required. They may 

also be shared across different Job Categories.

For example, appropriate Cost Groups for the Motorpartz demo database, under Job Type 

’Full Service’ and Job Category ’Replace Parts’, may be ‘Parts’, ’Labour’, ’Fitting Costs’, 

’Consumables’, and ’Cleaning’.

To set up cost groups:

1 Select Setup > Setup Cost Groups from the Job Costing menu. The Setup Cost Group 

search screen appears:

2 Click New. Enter the first of the required Cost Groups.

Job Costing Setup Cost Groups

Field Description

Description A descriptive name for this Cost Group. Descriptions could be taken 

from the Job Costing Analysis (‘Setting Cost Groups’ on page 22).

Short Code A short code to match the Cost Group description. This can be up to 

3 characters long.
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3 Click Save to save data or Cancel to lose all entries made.

To add another Cost Group, click New and repeat the process.

Setting Cost Types
A Cost Type is the (optional) lowest level of categorisation of a job. Cost Types are used to 

describe a product or activity, which can be added to other Cost Type products or 

activities, to make up a Cost Group (‘Setting Cost Groups’ on page 22). A Cost Type activity 

or product can be made up of one or more items in the stock module.

For example, appropriate Cost Types for the Motorpartz demo database, under the Cost 

Group ‘Labour’, may be ‘Labour Standard’, ‘Labour 1.5 Time’, and ‘Labour Double Time’. 

Appropriate Cost Types for Motorpartz under the Cost Group ‘Cleaning’ may be ‘Tyre 

Cleaning’, ‘Engine Cleaning’ and ‘Interior Cleaning’.

To set up Cost Types:

1 Select Setup > Setup Cost Types from the Job Costing menu. The Setup Cost Type 

screen is displayed.

Copy From Quote If information for this Cost Group needs to be copied from the 

quote to the Timesheet, Purchases or Costs tabs, select the 

required tab here. The information entered on the quote will not 

need to be re-entered in the selected tab but can be copied across. 

Leave as ’None’ if this functionality is not required.

Show On Quote The information in the selected tab can be changed after copying 

from the quote.

Allows specific Cost Groups to be displayed or not displayed on user 

defined forms (commonly the quote form).

Consolidate Used with user-defined Clarity forms to present certain Cost Groups 

as consolidated into one total cost, e.g. Total Labour - but parts 

detailed. Leave unselected if each group's costs are required to be 

shown separately, in detail.

Job Costing Setup Cost Type
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2 Click New. Type in the first of the required Cost Types.

Job Costing Setup Cost Type Detail

Field Description

Description A descriptive name for this Cost Type. Descriptions could 

be taken from the Job Costing Analysis (‘Job Costing 

Analysis’ on page 11).

Short Code A short code to match the Cost Type description. This can 

be up to 3 characters long.

Copy From Quote To If information for this Cost Type needs to be copied from 

the quote to the timesheet or costs tab, select the 

required tab here. Leave as ’None’ if this functionality is 

not required. If selected, the information entered on the 

quote will not need to be re-entered in the chosen tab.

The information in the selected tab can be changed after 

copying from the quote.

Show On Quote Select this option to display the Cost Type on the quote.

Consolidate Select if all Cost Types are to be consolidated into one 

invoice line e.g. multiple entries of normal labour are 

totalled as one entry line. Leave unchecked if each type's 

costs are to be shown separately.

Default Markup (%) The percentage of the standard markup. Enter as a 

number e.g. 12.45 will be calculated as 12.45%.

Default Overhead (%) The value of the standard overhead percentage. Enter 

this as a number e.g. 12.45 will be calculated as 12.45%

GL Code A General Ledger code for the Sales Account related to 

this item.
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3 Click Save to save data or Cancel to lose all entries made.

To add another Cost Type, click New and repeat this process.

Cost Group and Cost Type Defaults
Each Stock Item may also have its own default Cost Group (‘Setting Cost Groups’ on 

page 22) and Cost Type (‘Setting Cost Types’ on page 23). These defaults are used unless 

overridden at time of entry. Default settings may only be practical if stock items naturally 

fall into groups that reflect the way the jobs will be analysed.

A common technique is to create shortcut codes using ‘lookup only’ stock items to allow 

single key entry of costs on the Cost tab.

The default Cost Type and Group for a stock item is determined by the values in the Cost 

Group and Cost Type fields on the Stock Item > Extra Fields tab.

COSTGROUP and COSTTYPE are added to the STOCK_ITEMS table automatically when Job 

Costing is installed, however by default they do not appear on the Stock Items screen. Add 

these fields as Extra Fields in EXO Business Configurator > System > Extra Fields. Set up 

the fields as follows:

Default Purchase’s GL 

Code

A General ledger code for the Purchases Account related 

to this item.

Default Cost Group The Cost Group this item belongs to.

Field Value for Cost Groups Value for Cost Types

Table Name STOCK_ITEMS STOCK_ITEMS

Field Name COSTGROUP COSTTYPE

Display Name Cost Group Cost Type

Dialog Type Drop-Down Edit Drop-Down Edit

Lookup Table JOB_COSTGROUPS JOB_COSTTYPES

Key Field SEQNO SEQNO

Display Field COSTDESC COSTDESC
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In Account > Stock Item select the item you wish to specify the cost group and cost type 

for and then navigate to the Extra Fields tab. Select the codes you require.

If there are no values in these fields, then the user is expected to choose the Cost Type 

(and Group if required) on each line in Job Costing.

N O T E

The Stock Items Details Screen can also be accessed from any Job Costing screen that has a 

stock code. Double-click on the stock item to access the Stock Items Details Screen.

Setting Job Resources
MYOB EXO Job Costing has a Job Resource table that is similar, but distinct from the Staff 

table. This provides the following benefits:

• Allows the recording of time against non-staff resources such as plant and 

equipment, as well as employees.

• Can help to keep staff cost rates private by using an anonymous stock code.

• Gives the ability to default an activity stock code to each employee to speed up keying 

and help prevent mistakes.

• Gives the ability to separate timesheet employees from the users of the EXO Business 

system, to ensure they are not unnecessarily shown in the login screens.

N O T E

All existing employees are automatically added into the Resources table when Job Costing 

is installed.

Stock Item Costing Setup
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To add and review Job Resources:

1 Select Setup > Setup Job Resources from the Job Costing menu. The Setup Job 

Resources screen is displayed.

2 To add a new resource, click New. Enter the required Resource Name, and other 

required information.

Job Costing Setup Job Resources

Job Costing Setup Job Resources Detail
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3 Click Save to save data, or Cancel to lose all entries made.

To review an existing entry, double-click an entry to display the resource details. 

The cost and charge rate for that employee will be taken from the stock 'activity' code.

T I P

Take some time to review the list and any staff members who are not involved in time-sheeted work 

should be marked as inactive. Also take the opportunity to enter the initials into the Short code field 

as this will speed up entry. Similarly, if the ‘Labour’ stock code being used is commonly the same one 

for a resource, enter this into the Default Stock Code edit box. The default stock code will be used 

only if the exact short code is typed into the timesheet. 

If searching for the resource, the stock code will need to be nominated manually. To disguise the cost 

rate, make the stock code one that cannot be obviously related to the employee other than through 

the Job resource form. If privacy is required, remove the option to set up Job Resources from all but 

the supervisor's menu once the rates have been set against each employee (resource).

Setting Job Flags
There are a number of system-defined Job Flags that control the workflow and offer the 

opportunity to build in some customisable business logic constraints.

There are also a number of user-definable job flags that can be manually set. Examples of 

these might be ‘Awaiting parts’ or ‘Awaiting credit approval’. These flags cannot be raised 

automatically by a change in job status like the systems flags. They can be very useful for 

reporting or controlling the flow of jobs around the business. All user flags are assumed to 

be False when the job is created, so the flag name should be phrased to reflect this, e.g. 

Field Description

Staff If this resource is a staff member, select them from the 

drop-down menu. If it is a non-staff resource, leave this field 

blank.

Name A descriptive name for this Resource.

Short Code A short code to match the name (initials) Resource 

description.

Title Job title or use.

Default Stock Code The default stock code associated with the resource. Used 

to save time keying timesheets.

Active Select to mark the resource as active, to ensure it appears in 

Job Costing resource selection lists.

Filter SQL to Refine 

Stock Item Search 

For Times

A partial SQL ‘where’ clause can be entered here to filter the 

stock search window.
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‘Quality Checked’ is false until checked. ‘Awaiting parts’ is false until checked. The list of 

jobs that are ‘Ready for installation’ might represent the ‘installers’ in-tray of work. The job 

Search is highly configurable and will remember the combination of flags and statuses 

picked as default search list.

To set up Job Flags:

1 Select Setup > Setup Job Flags Descriptions from the Job Costing Main Menu. The 

Setup Job Flags screen is displayed.

2 Double-click a Flag Code to edit the description.

3 Click Save to update the description.

Up to 15 flags are accommodated. Unlike Job Status (‘Setting Job Statuses’ on page 18), 

multiple flags may be set on any particular job.

Job Costing Setup Job Flags
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Setting Quote Terms

To set the standard quote terms:

1 Select Setup > Setup Quote Terms from the Job Costing menu. The Setup Quote 

Terms screen appears:

2 Enter the standard set of terms and conditions of a quote. 

3 Click OK to save the information, or Cancel to lose the entry made.

Job Costing Setup Quote Terms
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Install/Upgrade Job Costing

Understand Job Costing Structure

Set-up Job Types, Statuses and Categories

Set-up Cost Types and Groups

Set-up Job Resources

Set-Up Job Flags

Adding Quote Terms
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Profile Settings

In this unit you will learn 
what profile setting 
control which parts of 
Job Costing

By the end of this unit, you will be able to:

Maintain Job Costing Company Profiles

Maintain Job Costing User Profiles

Maintain Job Costing Computer Profiles
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Job Costing Profile Settings

Like most MYOB EXO Business products, the optional configuration settings in Job Costing 

are established by the use of profile settings, edited in the EXO Business Configurator 

application. There are three levels of settings:

• Company profile settings (‘Job Costing Company Profiles’ on page 35) - These are 

global to the database and control all users and computers.

• User profile settings (‘Job Costing User Profiles’ on page 40) - These settings can vary 

according to the user logged on to EXO Business.

• Computer profile settings (‘Job Costing Computer Profiles’ on page 45) - These 

settings can vary according to the computer that EXO Business is being run on.

To configure profile settings, open the EXO Business Configurator application and select 

the Profiles tab. Select the Job Costing module filter to restrict the available settings to 

those that apply to the Job Costing module.

Individual profile settings can be found by searching for keyword on their descriptions or 

by their internal name. In the profiles listed below the internal name is also shown for your 

convenience. To change the search field to operate on internal name use the combo to the 

left of the ‘Find’ toolbar area.

Viewing Profile Settings
Setup > Setup General Info

The General Settings window displays read-only information about the Job Costing system, 

allowing you to view the values specified by the Job Costing profile settings from within 

the Job Costing module.

Open the General Settings window by selecting Setup General Info from the Setup menu 

of the main Job Costing window.
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Job Costing Company Profiles
The following Company-level profile settings can be configured in the EXO Business 

Configurator for the Job Costing module.

Allow editing of Locations of transaction lines

Enable this setting to allow editing of Locations (From & To Loc) of each individual 

transaction line on a job in Job Costing. Note that the To Loc file is only editable if 

JOBMOVESTOCKONHAND & JOBMOVESTOCKONINVOICE profiles are not enabled.

Allow Foreign Currency Debtors in Job Costing

This allows for the use of Foreign debtors in Job Costing. You must make sure though that 

you Do Not have foreign debtors Sub Jobs under a local currency Master as this may cause 

problems when invoicing via the Master Job. 

Also be warned that converting from a one debtor to another will not refresh the currency 

rate or tax codes on a job.

Allow invoicing of sub jobs from master jobs

Enable this setting to allow invoicing of sub jobs from a master job, i.e. a single 

consolidated invoice is created for the master job and all of its sub jobs. This will coincide 

with the check box ‘Allow Invoice via Master Job’ on Sub-Jobs that you want to be 

included.

Best pricing and discounting in Job Costing

This option is enabled by default. Disable this option to disable discounting and best price 

checking in Job Costing.

Caption for 'Our ref'

A caption for the Our ref field on the Details tab of the Job Details window (‘Job Overview’ 

on page 70). It gives you another field of information you may wish to save.

Cost field to use on Quote tab

Select the Cost field to use on the Quote tab: Standard, Average or Latest.

Cost method to use on Job Time and Cost tabs

Select the Cost method to use on time and cost tabs. Average, Last, Standard (static cost) 

to be used when entering transactions via the Job Time entry or Cost Entry tabs. Job Quote 

entry has its own distinct and independent setting.

Default retention rate for Job Costing

Default base retention percentage rate for Progress Billing (See Advanced Job Costing 

Guide).
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Enable job code or reference number on sales order and debtor invoice entry 
screens

Enable this option to record an optional job code or reference number on the Sales Order 

and Debtors Invoice entry screen.

Get general ledger P/L revenue accounts from

Select where the general ledger P/L revenue accounts are sourced from. Choose from:

• Stock Item

• Job Header

• Cost Type

Integrate timesheets with PayrollEnterprise

Enable this setting to activate integration with EXO Payroll (‘MYOB EXO Payroll Integration’ 

on page 96). This allows you to export timesheet data recorded against jobs to EXO Payroll.

Job Cost Billing Mode

Enter a list of billing modes to be available when entering new Jobs.

The list may include:

• C = Charge-up

• P = Progress Invoice

• A = Create Asset

• Q = Ex-Quote

The first in the list is the default billing mode.

E.g. CP would restrict the available modes to Charge-up or Progress Invoice modes, with 

Charge-up being the default presented option if none are specifically selected.

The default value is CPAQ.

Job Cost Management Screen Auto Refresh Interval

Job Cost Management Screen auto refresh interval in minutes. Default value = 0, i.e. no 

auto refresh.

Job Overview Screen - Warning Threshold when Loading Jobs

This value determines when to warn users if they are about to load too many records into 

the Job Overview screen (‘Job Overview’ on page 70) (if the user attempts to load too 

many records, the system may appear to freeze). This value is the number of records that 

will be loaded before displaying a warning. The default value is 1,000; the optimal value 

will vary depending on the performance of your network and PCs.



© Copyright 2013 MYOB Technology Pty Ltd

Unit 2—Profile Settings

 37

Job Purchase orders use Quote line Cost

If this setting is enabled, Purchase Order lines generated from the Job Quote tab use the 

cost price as specified on the quote line. If the supplier uses foreign currency, the Quote 

line cost will be converted to the equivalent in that currency. If this setting is disabled, the 

cost price on the Purchase Order line will behave as though the Purchase Order was being 

generated normally, using normal supplier price logic, rather than from the quote line.

Job Purchase orders use Quote line price

If this setting is enabled, Purchase Order lines generated from the Job Quote tab use the 

selling price as specified on the quote line.

Job Quote Labour Allowance calculation

If this setting is enabled, the total quote line Labour allowance is to be considered a 

multiple of line unit labour allowance times the total quantity on that line.

If the setting is not enabled, it is considered to be an absolute value per line. This affects 

the Total labour allowance displayed at the bottom of the quote screen.

T I P

You can predefine a labour allowance for all Stock codes by adding an extra field 

X_LABOUR_ALLOWANCE of Type DOUBLE with a default value of 0 to the STOCK_ITEMS Table. This 

value will be passed to the quote whenever you insert a new line.

Link 'Our ref' to sales order number lookup

If this setting is enabled, you can enter the number of the Sales Order associated with a job 

into the Our ref field on the Details tab of the Job Details window (‘Creating Jobs’ on 

page 49). The Sales Order can then be viewed by selecting View Sales Order from the 

Utilities menu.

Resources - Check for Resource Over-Allocations

If this setting is enabled, the system checks for overlaps and over-allocations when 

allocating resources or altering resource allocation. This includes cases where a resource 

allocation overlaps another allocation of the same resource, and when the resource is 

allocated for more than the target hours per day. If any resources are over-allocated, you 

are presented with a warning message, and given the option to view and correct the over-

allocations.

Resources - Synchronise Job and Resource Dates

If this setting is enabled, the system checks that start and end dates/times for resource 

allocations are within the Start Date - Due Date range. If allocations fall outside this range, 

you are presented with a warning message, and given the option to view and correct the 

allocation dates.
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PayrollEnterprise export location

This setting must be configured when integrating with EXO Payroll (‘MYOB EXO Payroll 

Integration’ on page 96). Specify the root directory of the EXO Payroll installation, e.g. 

C:\Payrollv.

PayrollEnterprise Database Location

This setting must be configured when integrating with EXO Payroll (‘MYOB EXO Payroll 

Integration’ on page 96). Specify the database directory of the EXO Payroll installation, e.g. 

C:\Payrollv\DATABASE.

SQL statement to refine stock item search for costs

An SQL statement to refine search criteria for stock on the Cost Tab of the Job 

Management Form. e.g. S.STOCKGROUP <>4 (if Labour is stock group 4 it will not be 

included in the results of the search).For further assistance contact your EXO Business 

trained professional.

SQL statement to refine stock item search for times

An SQL statement to refine the search criteria for stock on the Timesheet Tab of the Job 

Management Form e.g. S.STOCKCODE like '%LABOUR%' (if the stock code is LABOUR15, 

‘labour - time and a half’ will be included in the search result). For further assistance 

contact your EXO Business trained professional.

SQL statement to select cost of sales GL accounts

Search criteria, e.g. WHERE ACCNO<200. This example applies if cost of sales GL accounts 

is numbered less than 200. For further assistance, contact your EXO Business trained 

professional.

SQL statement to select sales GL accounts

Search criteria, e.g. ACCNO>1000. This example applies if Sales GL accounts are numbered 

greater than 1000. If Sub-Accounts are enabled, aliases must be used for ambiguous field 

names. Aliases are A=GLACCS and S=GLSUBACCS, e.g. A.ACCNO>2000 AND 

S.SUBACCNO<3.

For further assistance contact your EXO Business trained professional.

Sub job transactions add to master job totals

Select this option to automatically add Sub-job invoice totals to the Master Job.

Time sheet default end date

Select the default end date for new timesheets. Choose from the Due date, the Start date 

or today's date.
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Use current date on Time sheets entry

If this setting is enabled, the start dates on Time Sheets entry will be the current date; 

otherwise, the Job Start date will be used, but only if it is defined. If no Job Start date is 

set, Time Sheet start date will use the current date instead.
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Job Costing User Profiles
The following User-level profile settings can be configured in the EXO Business 

Configurator for the Job Costing module.

Allow creation of new Make, Model and Class

If this setting is enabled, Makes, Models and Classes can be created from the 

Serviceable Units window (‘Overview’ on page 2).

Allow editing of job cost invoicing

Allows immediate editing of Invoices as they are generated from Jobs. Changes made 

will not adjust the values of the cost lines that were used to create the Invoice (this 

must be done on the Invoice tab of the Job), but the value of the invoice will show on 

the Job Analysis tab. By enabling this option, you are also be able to generate Invoices 

on a job that has no currently invoice-able lines in the ‘Ready to Invoice’ state, e.g. 

Initial non-refundable down payment or progress based Invoice.

Calculate 'Hours' from 'Start' and 'End' times in timesheet entry

Enable this option if you do not require the user to enter 'Total Time'. If you select this 

option, 'Total time' will be automatically calculated from the start dates and start times 

entered. Many users find that entering times and dates is inefficient and prefer to enter 

total hours.

Default Category

Default Category (‘Setting Job Categories’ on page 20) when entering a new Job in Job 

Costing.

Default Job Status

Default Job Status (‘Setting Job Statuses’ on page 18) when entering a new Job in Job 

Costing.

Default Job Type

Default Job Type (‘Set up Job Costing’ on page 16) when entering a new Job in Job Costing.

Default Status of Job Transactions on Entry

Select the default status of new job transactions. Choose from:

• C - Committed

• W - Write-off

• R - Ready to Invoice

You might set this value to 'R' if the transactions you are entering do not usually require 

any further checking after initial entry and you therefore want all transactions entered 

onto a job to be automatically ready to appear on the next Job Invoice.
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Default the Job Manager as Sales person on invoices from Job Costing

Enable this option to set the default Sales Person on invoices from Job Costing to the Job 

Manager. If the option is disabled, the default Sales Person is set to the currently logged in 

user.

Default the Job Manager from Debtor Account Staff

Enable this option to obtain the default Job Manager from the Debtor Account staff. If the 

option is disabled, the default Job Manager is set to the currently logged in user.

Display internal job number after saving

Enable this option to display the job number every time a job is saved.

Extra Job Costing Search Fields

The format to extend Extra Search Fields is: 

• ADatabaseFieldName=FriendlyCaption=SearchBehaviour

• Multiple fields are separated by commas

• The =FriendlyCaption=SearchBehaviour is optional

For Example: X_AFIELD=A Caption,X_ANOTHERFIELD=Another Caption,X_THIRDFIELD

Additional control over the extra search field behaviour is set as follows: 

If no behaviour parameters are passed in, it assumes a default search behaviour of GSWU 

where:

• =G - show this field as an optional visible column in the search grid.

• =S - add this field as part of the select statement.

• =W - make this field value a condition in the WHERE clause.

• =U - force a character to uppercase for comparison. (String Fields)

• =E - use Exact match (=) in the where clause rather than LIKE. (String Fields)

For Example: X_MyField1=Mycaption=GSWUE,X_Myfield2=MyField2=E

Ambiguous field names (field names that exist in both tables) should be prefixed by a table 

alias. 

For Example Alias.FieldName,Alias2.FieldName

The list of aliases is:

• J=JOBCOST_HDR

• A=DR_ACCS

• S=JOB_STATUS

• C=JOB_CATEGORIES

• R=JOB_RESOURCE_ALLOCATION
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• F=JOBCOST_FLAGS

• G=JOB_TYPES

• H=STAFF

Go direct to job management screen on startup

Enable this option to display the Job Management screen on startup.

Hide tabs in Job management screen

Allows you to hide Tabs on the Job Management Screen. Enter the codes for all tabs you 

want to hide, separated by commas. Available codes are:

• Q = hide the Quote Tab

• T = hide the Time Tab

• C = hide the Cost Tab

• A = hide the Analysis Tab

• P = hide the Purchase Tab

• I = hide the Invoice Tab

• D = hide the Documents Tab

• E = hide the Extra Fields Tab

• H = hide the History Tab

• S = hide the Sub-jobs Tab

• V = hide the Activities Tab

• X = hide the Dashboard Tab

• B = hide the Billing Schedule Tab

For example, enter ‘Q,T,I’ to hide the Quote, Time and Invoice tabs.

Hide Quote Margin

Enable this option to hide the Margin field displayed at the bottom of the Quote/Budget 

tab (‘Entering Quote/Budget Information’ on page 80).

Hide Quote Markup

Enable this option to hide the Markup field displayed at the bottom of the Quote/Budget 

tab (‘Entering Quote/Budget Information’ on page 80).

Hide Quote Total Cost

Enable this option to hide the Total Cost field displayed at the bottom of the 

Quote/Budget tab (‘Entering Quote/Budget Information’ on page 80).
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Hide Resource Planning Gantt Form

This option hides the Resource Gantt form from the Main Job Management Screen.

Job costing custom button X caption

Custom button caption settings are available for each of the nine custom buttons. Enter a 

caption for the appropriate button.

Job costing custom button X command line

Up to nine custom buttons are provided for you to add your own shortcuts to many of the 

main screens.

For the desired button, specify the details of the sub-program to be run whenever you 

press that button.

• To run an external program, enter:

‘MyProg.EXE <LOGIN> <CURRENT>’

• Where <LOGIN> passes the database connection details and <CURRENT> passes out 

the key field identifier (most commonly the SEQNO) of the current record that you 

have loaded on the screen at the time that you press the button. 

• Any parameter entered with the extension MYREPORT.CLR will assume that you wish 

to run a clarity report and will call Clarity directly. It is not necessary that Clarity.EXE 

exist to do this.

• Any parameter entered with an extension of MYREPORT.RPT will assume that 

CRYSTAL.EXE should be run first.

Job Costing Read-Only Access

Enable this profile to restrict users to read-only access in the Job Costing module.

Job Default due days

Default number of days after Job start date.

Job Default end time

Default number of hours after Job start time.

Job Default follow-up days

Default number of days for follow-up after Job completion.

Job default quote expire days

Default number of days for job quotes to expire. The defaults is 14 calendar days.

Override Job Codes

Enabling this option allows the user to override the system-assigned Job Code any time.
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Prompt if different delivery address on Job

Enable this profile to be prompted whenever a debtor's current delivery address is not the 

same as the delivery address in a job. Probable use would be where a job is being 

rejuvenated or repeated after a long period of time, and the debtor has moved premises.

Prompt if Job Code is blank

If this option is enabled, the user is prompted if the Job Code on a transaction line is blank 

in Purchase Orders and Creditor's Invoices. You might disable this if only a proportion of 

purchases relate to jobs.

Remember Stock Search Form size

Enable this option to remember the size of Stock Search Form between sessions.

Restrict access to jobs on default branch only

Enable this profile to restrict access and creating of new jobs to the default branch only.

Restrict Timesheet entry to Resource associated to logged-in Staff

Enabling this option restricts the Resource to the Resources associated with the currently 

logged-in Staff member.

Serviceable Unit Custom Button1 Caption

The Serviceable Units window contains single a custom button (See Advanced Job Costing 

guide). Enter a caption for the button.

Serviceable Unit Custom Button1 EXE

A single custom button is provided on the Job Costing window for you to add your own 

shortcuts to many of the main screens.

Specify the details of the sub-program to be run whenever you press that button (see the 

information on the Job Costing custom buttons above for details).

Show Job Overview screen needs refresh warning

The Job Overview tab (‘Job Overview’ on page 70) does not refresh automatically as job 

details are changed. If this setting is enabled, a warning appears on the Job Overview 

whenever job details change, informing the user that they need to refresh the display.

Show Resource Overview screen needs refresh warning

The Resource Overview tab (‘Resource Overview’ on page 75) does not refresh 

automatically as job details are changed. If this setting is enabled, a warning appears on 

the Resource Overview whenever job details change, informing the user that they need to 

refresh the display.
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Show the ‘Resource Allocations moved with Job’ warning

If this setting is enabled, a warning appears on the Job Overview tab whenever a job with 

resources attached to it is moved, informing the user that the associated resource 

allocations have changed.

User can modify visible columns in grids

If this option is enabled, the Select visible columns option is available in the right-click 

menu for all ExoGrids in the Job Details window.

User has Job Administrator Rights

Enabling this option means that the user can edit the status of jobs that contain the 

characteristic of ‘Job Read Only’.

Warn if cash sales account is used on jobs

Enable this option to alert the user if they are about to create a job to a cash sale, or if they 

do not choose the account. It is advisable to do this, as it will prevent invoices 

inadvertently being created as a cash sales.

Weekly timesheet resource auto defaults from staff login

If there is a matching resource for the staff login, then the weekly timesheet opens with 

that resource.

Job Costing Computer Profiles
The following Computer-level profile settings can be configured in the EXO Business 

Configurator for the Job Costing module.

Asset default location

The default output location when creating an asset in Job Costing.

Job work in progress stock location

The Work in Progress stock location for Job Costing. This is normally defined when setting 

up the Default Location in EXO Config > Essential > EXO Job Costing.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Maintain Job Costing Company Profiles

Maintain Job Costing User Profiles

Maintain Job Costing Computer Profiles
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Job Creation & 
Searching

In this unit you will learn 
the basics of Job Costing, 
including creating new 
jobs.

By the end of this unit, you will be able to:

Understand the basics of Job Costing

Create a New Job

Create a Project

Create a Sub Job

Create a Duplicate Job

Search for an Existing Job

Create and Allocate Resources
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Job Costing Workflow

The Job Costing workflow is represented by the following diagram:

Job Costing Integration
The Job Costing module integrates with EXO Business as follows:

Job Costing Overview

Job Costing Diagram
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Creating and Searching for Jobs

Creating Jobs
New jobs are created from the Job Management screen. From here new jobs, sub jobs and 

duplicate jobs may be created.

To create a new job:

1 Select Account > Job Management Screen from the main Job Costing menu. The 

following window appears.

2 Select New to begin a new job.

A warning alert may pop up stating that unless a customer account is chosen the job will 

be saved as CASH ONLY. Click OK. This will allow entry of details into the new Job Screen.

N O T E

Whether or not this warning appears is controlled by the Warn if cash sales account is used 

on jobs ‘Job Costing Profile Settings’ on page 34.

Job Costing Search Tab
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3 The main job entry window is displayed:A unique code for the job. It may be up to 15 

alphanumeric characters. If a code is not entered, it will default to the system-

assigned job number.

Job Costing New Job Creation
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Job Details

Customer

Field Description

Code A unique code for the job. It may be up to 15 alphanumeric 

characters. If a code is not entered, it will default to the system-

assigned job number.

Title The title of the job. This should be a short recognisable job 

description.

Status Job Status (‘Setting Job Statuses’ on page 18) to identify the current 

stage of the job. Select the appropriate status from the drop down 

list.

If the status is unable to be changed, then the current status of the 

job may dictate that the job is entirely read-only and only an 

administrator can alter it. This is controlled by the Make job read 

only option when setting Job Statuses (‘Setting Job Statuses’ on 

page 18).

Type A Job Type (‘Set up Job Costing’ on page 16) selected from the drop 

down box. The default is set by a user-level profile setting (See 

page 40).

Category A Job Category (‘Setting Job Categories’ on page 20) selected from 

the drop down box. The default is set by a user-level profile setting 

(See page 40)

Account This specifies the Account that the job is for. You can select the by 

simply typing the name in question or using ?

Campaign Wave Allows selection of the Campaign that the job relates to. This will 

then show in the Activity Tab in CRM Campaign

Opportunity Shows the Opportunity that the job was raised from during Convert 

from Quote

Field Description

Job Mgr A staff name from the drop down box. Defaults to the Staff on the 

Debtors account by profile setting, but can be over-written. This 

staff member can override the salesperson on all invoices created 

from a job, (subject to a user profile setting).

Cust Order No A customer order number, if required.
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Contact This field displays the Contact for the job, but may be left blank. 

Contacts will allow for example, job/debtor-related subcontractors 

or Site foreman to be stored.

Clicking the edit button will display a list of known contacts 

associated with the account. Double click to select or click New to 

add a new contact to the account. You can also tick Search On All 

Contacts to search on all contacts in the database who may relate 

to this job.

See the MYOB EXO Business online Help for instructions on adding 

a Contact.

Site Address The address(es) of the job site. Manually enter an address, or use 

the Additional Addresses (‘Selecting Site Addresses’ on page 55) 

button.
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Dates

Others

Field Descriptions

Create Date Date and time that the job was created. Cannot be edited.

Quoted Date Record a date and time when the quote was created. 

Start Date Record the start date/time of the job. Either in advance or when 

the job actually starts.

Due Date Date and time that the job is expected to be completed. Defaults to 

Start time + the value of the Job Default due days user-level profile 

setting (See page 43).

Completed Date Date and time of actual completion.

Follow-Up Date Defaults to the Job Default follow-up days user-level profile setting 

(‘Job Default follow-up days’ on page 43). Designed to provide a 

way to report on jobs that are due for service, or customer 

satisfaction survey at an appropriate time after an installation

Field Description

Branch Enter the Branch code for this job. Defaults to the user's branch 

profile setting.

WIP Loc The Work in Progress stock location. Defaults to the Job work in 

progress stock location computer profile setting (‘Job work in 

progress stock location’ on page 45). This will only show locations 

that have been set as Job Costing Work In Progress Location in EXO 

Config > Admin > Stock Locations.

Entered By Select an active staff member from the drop-down menu. Defaults 

to the currently logged-in user.

Our Ref A reference that can be searched on the main job search screen.

If a Sales Order has been created for the job, enter the Sales Order 

number here. You can view the Sales Order by selecting View Sales 

Order from the Utilities menu, provided the Link 'Our ref' to sales 

order number lookup profile setting has been enabled.

Billing Mode The billing mode determines how the Job will be charged. Choose 

from:

Charge-up - charge items added to the job

Invoice Ex-Quote - the quoted value will be charged.

Manufacture - output items - the job will create stock assets 

(items) for on-sale

Progress Invoices - Allows for the generation of staged invoicing 

that actuals can be allocated against. Used in larger industries such 

as Construction and Building.
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Tabs

Timestamps 

Key fields such as the Description and Notes support the ability to quickly ‘stamp’ the field 

with the current logged in user name, and the system time and date.

To create a time stamp, press CTRL+T in a supported field. A time stamp like the following 

is inserted at the current cursor point:

<< FRED Tuesday, April 1, 2003 at 09:16 >>

Common Phrases

A library of common phrases can be built to save typing and assist with retaining a generic 

format to notes. 

Extra Field Optional addition fields that can be used to record business specific 

information, contained in extra fields set up by an MYOB EXO 

Business partner.

Field Description

Description Enter any extra explanatory details relating to the job, which can be 

included on the invoice.

The content of this field is scanned when you select the Extensive 

job search option. If there is a value in this field then the tab will 

appear highlighted.

Notes Enter general narration Notes about the job. This field is usually 

used for private notes, and is not included in the customer invoice. 

The content of this field is scanned when you select the Extensive 

job search option. If there is a value in this field then the tab will 

appear highlighted.

Serviceable Units This tab only appears if the Serviceable Units (See Advanced Job 

Costing guide) module is installed. It allows a list of serviceable 

units to be assigned or created for the job. At line level the 

particular serviceable unit can be selected from this list.

Output Items Allows pre-loading the output item (asset stock codes) that will be 

produced from this job.

Job Flags These are flags (‘Setting Job Flags’ on page 28) that can be set 

against the job. Multiple flags can be checked. There are two 

groups of flags:

• System Flags - these are predefined

• Custom Flags - these are created by during implementation.
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To select or create a common phrase press CTRL+' (single quote), or CTRL+" (double 

quote) in a supported field. The Common Phrases window appears:

To add a phrase, type the phrase and click the Add Phrase button.

To select a common phrase to the text box, begin typing the phrase and the cursor will 

focus on the nearest match in the search grid. Either click OK to select the highlighted 

phrase, or double-click the phrase required.

To delete a phrase from the list, highlight the phrase to be deleted and click the Del. 

Phrase button.

Selecting Site Addresses

To assist in site address entry, an additional Select Address button is available on the 

toolbar.

Click this button and a prompt will appear to give the option to search all addresses. You 

have the option of ignoring the specified account (Yes) or restrict addresses to the account 

specified (No).

A list of addresses to select from is then displayed:

Job Costing Common Phrases

Extra Delivery Address



© Copyright 2013 MYOB Technology Pty Ltd

Set up and Process EXO Job Costing

 56

Additional addresses may be added by clicking the New button or the desired address 

added to the job by selecting the appropriate address and clicking the Select & Close 

button.

Serviceable Units

Serviceable Units functionality is an optional module which is not installed by default. This 

tab may therefore be absent from your screen. Serviceable units refer to items on which 

work may be required. These could be assets of the company running the Job Costing 

module or assets owned by their customers (perhaps previously sold to the customer).

This detailed further in the Advanced Job Costing manual.

Output Items

Jobs may create products of value that are not invoiced directly to the customer, but 

instead create stock of value that can be sold via Debtors Invoicing or Sales Order entry 

(manufacturing). This is referred to as creating an asset. The output items are created as 

part of the invoicing phase of the job (‘Generating Invoices’ on page 108) and may be 

specified at that time but may also be pre-loaded here and later referenced in the Create 

Asset > Create Asset from Output Items routine (‘Creating Assets from Output Items’ on 

page 116) on the Invoice tab.

Saving the Job

Once the header information for the job has been entered, three options for saving are 

available:

• Save & Exit - saves the details and returns to the main search menu, ready to create 

the next job.

• Cancel - abandons all entries made.

• Save - saves data and continues with entering data on this job.

Once the job header has been saved, a series of tabs become available next to the Details 

tab. These are used to change from one type of entry to another associated with the same 

job:

• Quote/Budget (‘Entering Quote/Budget Information’ on page 80)

• Timesheets (‘Entering Time Costs’ on page 90)

• Costs (‘Entering Costs’ on page 99)

• Purchases (‘Entering Purchase Orders’ on page 106)

• Invoice (‘Generating Invoices’ on page 108

• Billing Schedule (‘Billing Schedule Tab’ on page 118)

• Analysis (‘Job Analysis Tab’ on page 127)

• Documents (‘Resource Allocation’ on page 74)

• History Notes (‘History Notes’ on page 122)
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• Activities (‘Activities’ on page 77)

• Dashboard (‘Job Analysis Tab’ on page 127)

• Sub Jobs (‘Creating Sub Jobs’ on page 60)

The tabs may be reordered to a different sequence by dragging them to a new position. 

They may then be locked into this position via the menu by selecting Utilities > Lock Tabs. 

Most tabs contain a grid with resizable columns. By selecting Utilities > Lock Column 

Widths you can prevent accidental resizing.

Both of these settings are toggles. Clicking them a second time unlocks the setting.
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Creating Projects

Jobs can be organised under projects for display on the Job Overview tab (‘Job Overview’ 

on page 70) of the Job Management Screen. Projects act as containers for related jobs, and 

hold no job-related information themselves.

Projects can contain a hierarchy of master jobs with sub jobs, although projects 

themselves cannot be nested, i.e. one project cannot contain another.

N O T E

A sub job cannot be assigned directly to a project; sub jobs are assigned to a project when 

their master job is assigned to the project.

To create a new project:

1 On the Job Overview tab, right-click on the first job that you want to add to the 

project and select Add to Project. The Choose a Project window appears:

Job Costing Project View
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2 Click New to add a new project. The Project Details window appears:

3 Enter a name, code and description for the project, then click Save & Exit.

N O T E

The Status property displays ‘Active’ if the project has and jobs assigned to it and ‘Inactive’ 

if it currently has none.

4 The new project now appears on the Choose a Project window. Select it and click 

Select and Close.

The new project is created and the selected job is assigned to it. More jobs can be assigned 

to the project by selecting Add to Project from the right-click menu, then choosing the 

project from the Choose a Project window.

T I P

Jobs can be automatically assigned to projects when they are created. Select a project on the Job 

Overview tab, then click the New toolbar button or select New from the File menu. When the new 

job is saved it will be automatically assigned to the selected project.

To remove a job from a project, right-click on the job and select Remove from Project.

To edit a project's name, code and/or description, right-click on it and select Edit Project.

Job Costing Project Detail
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Creating Sub Jobs

Sub Jobs are jobs that are linked to a master job. They usually represent distinct parts of 

the job for the purpose of simplifying overall reporting. In every other way sub jobs are 

normal jobs.

N O T E

A master job must be created before a sub job can be entered.

To create a new sub job:

1 Choose File > New Sub Job from the Job Management window.

2 Select the master job that the new sub job is to be associated with from the Search 

window that appears.

3 Fill in all details in the same way as when creating a new Job (‘Creating Jobs’ on 

page 49).

The created sub job is numbered and is shown as a sub job on the Sub Jobs tab of the 

selected master job.

T I P

The job code for the sub job could include part of the master job number or code, for easy cross-

referencing.

Points to Note

A sub job can be identified by looking at the status bar at the top of the job.

To go to the master job from a sub job, click the View Master Job button (  ) on the 

toolbar of the sub-job.

The master job contains an extra Sub Jobs tab that contains a list of sub jobs attached to 

that master job.

Job Costing Sub Job Info



© Copyright 2013 MYOB Technology Pty Ltd

Unit 3—Job Creation & Searching

 61

The Analysis tab of a master job displays totals for all related sub-jobs:

I M P O R T A N T

A job cannot be connected to, or disconnected from a master once the job has been 

created. 

If the Allow invoicing of sub jobs from master jobs Company-level profile setting (‘Job 

Costing Company Profiles’ on page 35) is enabled, sub jobs are invoiced from their master 

jobs - a single invoice is created (‘Generating Invoices’ on page 108) for the master job and 

all of its sub jobs.

Job Costing Sub Job Analysis
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Creating a New Duplicate Job

A duplicate job can be easily created using an existing job as a starting point. If there are 

sub-jobs attached to the job being duplicated a prompt will appear to confirm whether the 

sub-job(s) are to be included. It is not necessary to duplicate all sub-jobs - select the sub 

jobs required to be duplicated.

To create a duplicate job:

1 Select File > New Duplicate Job from the Job Management menu. The following 

window appears

2 Double click the job to be copied. The following window appears to confirm to what 

extent the jobs details are to be duplicated.

3 Select the appropriate features of the job that are to be duplicated and click OK.

The newly created job is given the next appropriate number.

Job Costing Duplicate Job

Job Costing Duplicate Job Select
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If the Duplicate any sub-jobs option was selected, the following window will appear after 

the copy of the master job is saved:

4 Select a sub job to be added to the new job.

5 Click Add or double-click the job to be added.

6 Save the newly created sub job after making necessary alterations.

7 Continue adding until all required sub jobs are added.

8 Close the window.

N O T E

Subs jobs are not displayed on the master job screen until the master job is saved.

Job Costing Duplicate Sub Job
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Direct New Job Entry

The Direct New Job Entry window is a fast entry window that allows you to create new jobs 

quickly. Once created, new jobs can be edited as normal on the Job Details window 

(‘Creating Jobs’ on page 49).

Open the Direct New Job Entry window by selecting the Direct New Job Entry menu 

option.

N O T E

If the Direct New Job Entry menu option is not available, you will need to add it using the 

Menu Designer.

To create a new job using the Direct New Job Entry window, enter the details below and 

click Save.

After one job has been entered and saved using the Direct New Job Entry window, you can 

click New to enter a new job. The details of the saved job remain on the window (with the 

exception of the Code, Title, Account and Cust order no.) - this allows you to quickly enter 

multiple jobs with similar details.

Job Costing Direct New Job
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Job Details

Dates

Fields Description

Code A unique code for the job. It may be up to 15 alphanumeric 

characters. If a code is not entered, it will default to the system-

assigned job number.

Title The title of the job. This should be a short recognisable job 

description.

Status A Job Status (‘Setting Job Statuses’ on page 18) to identify the 

current stage of the job. Select the appropriate status from the 

drop down list.

If the status is unable to be changed, then the current status of the 

job may dictate that the job is entirely read-only and only an 

administrator can alter it. This is controlled by the Make job read 

only option when setting Job Statuses (‘Setting Job Statuses’ on 

page 18)

Type A Job Type (‘Setting Cost Types’ on page 23) selected from the drop 

down box. The default is set by a user-level profile setting (‘Job 

Costing User Profiles’ on page 40).

Category A Job Category (‘Setting Job Categories’ on page 20) selected from 

the drop down box. The default is set by a user-level profile setting 

(‘Job Costing User Profiles’ on page 40).

Job Mgr Select a staff name from the drop down box. This staff member can 

override the salesperson on all invoices created from a job, (subject 

to a user profile setting). 

Field Description

Quoted Record a date and time when the quote was created. 

Start Record the start date/time of the job. Either in advance or when 

the job actually starts.

Due Date and time that the job is expected to be completed. Defaults to 

Start time + the value of the Job Default due days user-level profile 

setting (‘Job Default follow-up days’ on page 43).

Completed Date and time of actual completion.
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Customer

Other

Field Description

Account Enter a customer code. If the code is unknown, enter ? and press 

TAB, select from displayed list.

Cust Order No A customer order number, if required.

Contact This field displays the Contact for the job, but may be left blank. 

Contacts will allow for example, job/debtor-related subcontractors 

or Site foreman to be stored.

Clicking the edit button will display a list of known contacts 

associated with the account. Double click to select or click New to 

add a new contact to the account. You can also tick Search On All 

Contacts to search on all contacts in the database who may relate 

to this job.

See the MYOB EXO Business online Help for instructions on adding 

a Contact.

Field Description

Entered Select an active staff member from the drop-down menu. Defaults 

to the currently logged-in user.

Our Ref A reference that can be searched on the main job search screen.

If a Sales Order has been created for the job, enter the Sales Order 

number here. You can view the Sales Order by selecting View Sales 

Order from the Utilities menu, provided the Link 'Our ref' to sales 

order number lookup profile setting has been enabled.

Description Enter any extra explanatory details relating to the job, which can be 

included on the invoice. 

The content of this field is scanned when you select the Extensive 

job search option. If there is a value in this field then the tab will 

appear highlighted
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Searching for an Existing Job
To search for an existing job, select Account > Job Management Screen, from the Job 

Costing main menu. The following screen appears

The Search tab is displayed by default. The following tabs are also available:

Job Overview (‘Job Overview’ on page 70)

Resource Overview (‘Resource Overview’ on page 75)

Applying Job Filters

The job filters at the top of the Search tab allow the search results to be 'filtered' to 

facilitate processing of jobs within certain 'ranges'.

By default all of the filter options are displayed, but if your implementation does not 

employ all of the categorisations of jobs you can hide selected options using the toolbar 

View settings.

T I P

The thin line between the filters and the search key can be dragged to use more or less screen space 

for the filter options.

Job Costing Search Tab

Job Costing View Menu
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Select the check box next to the filter title to enable that filter. This check box allows an 

entire filter to be enabled or disabled, without altering the individual settings of the filter 

items, e.g. in the example above, filtering by Job flags and Job statuses is enabled, but Job 

types do not form part of the filter.

Once a specific filter has been enabled, individual filter settings can be selected.

T I P

Right-clicking in an activated flag set provides the option to tick or un-tick all options in one step

The computer remembers the combination of selected filter options. This allows the 

search screen to be set up for specific workflow purposes at specific workstations or 

enables the options to be remembered if the user works in a consistent way.

Performing the Search

Once the optional filter options have been selected, enter text into the Search key field 

that will sufficiently narrow down the list of jobs returned in a search. This would be part 

of the job code, customer name, job title or 'our ref' reference field.

If the Extensive search option is selected, the Search key will also be checked against the 

contents of the description and notes fields. While more comprehensive, it will cause the 

search to take longer to list the results.

Clicking Search will list all jobs matching the statuses ticked in the box at top of the screen 

and the criteria entered into the Search key field.

Some job lines are colour-coded to indicate their status or job flags:

GREEN = Invoice Ready

RED = Completed

OLIVE = Archived

PURPLE = Overdue

Filter Description

Job Flags Tick these boxes to show jobs that have the selected job flags 

(‘Setting Job Flags’ on page 28) associated with them. Flags are 

updated whenever the job is saved. Their settings are based on the 

characteristics of the current job status.

Job Status

Job Types

Job Categories

Tick these boxes to show jobs that have the selected job statuses 

(‘Setting Job Statuses’ on page 18), types (‘Setting Cost Types’ on 

page 23) and/or categories (‘Setting Job Categories’ on page 20).

Resources Shows jobs that involve any of the resources selected.

Entered By

Serviced By

Select from a list of active staff members to show jobs that have 

been entered/serviced by them.
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From the list that appears, select the required job. The screen that is displayed shows the 

job details, as entered when the job was created. Changes can then be made to the job.

N O T E

The search result grid is an ExoGrid and can therefore be used to sort, shuffle or only 

display selected columns. Any extra fields that are added to the job header will become 

available as extra columns of the job list, although these columns are not matched against 

the search key.

Applying Custom Filters 

An additional customisable filtering mechanism can be used to filter the records displayed 

in the grid. This custom filter is accessible by right-clicking on the grid column headings 

and select Custom Filter. This method is common to many search grids within MYOB EXO 

Business. See the EXO Business online Help on ExoGrids for more information.

When a custom filter is active, the funnel icon will appear in the column headings. Select 

Clear Filter to remove the action of the filter. 
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Job Overview

The Job Overview tab of the Job Management screen (‘Job Overview’ on page 70) displays 

a Gantt chart, providing a graphical representation of projects and jobs with their 

scheduling and resource allocations.

N O T E

You must set up colours for Job Types (‘Set up Job Costing’ on page 16), Job Statuses 

(‘Setting Job Statuses’ on page 18), and Job Categories (‘Setting Job Categories’ on page 20) 

before using the Job Overview tab.

Job Filters

The job filters (‘Applying Job Filters’ on page 67) available on the Search tab are also 

available on the Job Overview tab. In addition to these filters, you can also search jobs by 

date by selecting options under Date Search.

You can hide the job filters to provide more room for the Job Overview chart by clicking 

the  button. 

Job Overview Chart

The lower section of the Job Overview tab contains two areas:

• An expanding list of all jobs and projects matching the filtering criteria is displayed on 

the left. Click the plus or minus boxes next to a job or project to expand or collapse 

Job Costing Job Overview
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the jobs underneath it. All projects are displayed first, with jobs that are not assigned 

to a project displayed underneath them.

• A Gantt chart showing all jobs and projects that match the filtering criteria is 

displayed on the right.

Projects are represented on the Gantt chart with arrowed bars ( ).

Jobs are represented as coloured bars. Select a value from the Colour Scheme control to 

determine what the colours will be used to represent - in addition to displaying jobs 

according to the colours set up for their Job Type (‘Set up Job Costing’ on page 16), Job 

Status (‘Setting Job Statuses’ on page 18), and Job Category (‘Setting Job Categories’ on 

page 20), you can also highlight jobs that have alerts or any custom flags enabled.

Where appropriate, resource allocations are displayed next to job bars.

N O T E

The chart does not update automatically as job details are changed. To update the chart, 

you must click Search again. If the Show Job Overview screen needs refresh warning User 

profile setting is enabled, a warning message alerts you when a job has changed. To set the 

chart to update itself at a set interval, configure the Job Cost Management Screen Auto 

Refresh Interval Company profile setting.

Navigating the Chart

Use the arrow buttons on the bar at the top of the chart to scroll it left and right

To change the zoom level of the chart, click the  and  buttons on the toolbar, or drag 

the bar at the top of the chart left (zoom in) or right (zoom out).

Click the  button to center the chart on the currently selected job/project, and expand it 

to fill the width of the display.

Click the  button to print a copy of the Gantt chart as it currently appears on screen.
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Editing Jobs

Hovering the mouse pointer over a project or job on the Gantt chart displays its details in a 

popup bubble:

Jobs can be dragged to change their dates:

• Click on the left edge of a job bar and drag to change the job's Start Date

• Click on the right edge of a job bar and drag to change the job's Due Date

• Click on the center of a job bar and drag to move the Start and Due Dates at once 

(keeping the job's duration the same)

N O T E

If resources have been allocated to a job, changing the Start and/or Due Date changes the 

resource allocation dates.

Double-clicking on a job opens the Job Details window (See “Creating Jobs” on page 49.), 

where the job can be edited.

Double-clicking on a project opens the Project Details window (‘Creating Projects’ on 

page 58), where the project can be edited.

Right-Click Options

Right-clicking on a job or project on the Job Overview tab gives access to the following 

options:

• New Job - create a new job (‘Creating Jobs’ on page 49)

• New Sub Job - create a new sub job (‘Creating Sub Jobs’ on page 60)

Job Costing Job Overview Chart
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• New Duplicate Job - create a new job by copying an existing job (‘Creating a New 

Duplicate Job’ on page 62)

• Attach to Master Job - assign an existing job as a sub-job of an existing master job

• Add to Project - add the selected job to a project (‘Creating Projects’ on page 58) and 

optionally create a new project

• Remove from Project - removed the selected job from the project it is currently 

assigned to

• Edit Project Details - edit the details of the selected project

• Assign Resources - edit the resource allocations (‘Resource Allocation’ on page 74) for 

the selected job
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Resource Allocation

Resource allocation allows resources such as staff and plant to be booked against a job. 

This can also generate appointments in the Microsoft Outlook calendar.

Creating a Resource Allocation

Resource allocations can be created in several ways:

• Right-click on a job on the Job Overview tab (‘Job Overview’ on page 70) of the Job 

Management screen and select Assign Resources.

• Click the Resource Allocation button on the toolbar of the Details tab.

• Click the Resource Allocation button on the toolbar of the Activities tab.

The Setup Job Resource Allocation window appears.

Enter commitments for staff or plant, then click Save & Exit.

You can see a graphical overview of all resource allocations on the Resource Planning 

(‘Resource Overview’ on page 75) tab.

N O T E

When allocating resources, the system checks for over-allocations and checks that the Start 

and End Dates fit within the dates for the job. If either check fails, you are presented with a 

warning message. 

Two profile settings, Resources - Check for Resource Over-Allocations and Resources - 

Synchronise Job and Resource Dates are available to enable/disable these checks. If the 

job's Start and/or Due Date are changed, the resource allocation dates are automatically 

updated.

Job Costing Resource Allocation
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Creating Tasks

When a resource allocation is created, a Task for the relevant staff member is 

automatically created in the EXO Business system. Tasks can be viewed in the Task 

Scheduler interface, which is available on the main interface of both the Job Costing 

module and the EXO Business core.

Integration with Microsoft Outlook

Individual allocations can be sent to Microsoft Outlook as calendar appointments by 

clicking the Create Appointment button. The job description is used as the body of the 

message.

N O T E

After an Outlook appointment has been created, changing an entry in Job Costing or in 

Microsoft Outlook will not update the other entry.

Resource Overview

The Resource Overview tab available on the Setup Job Resource Allocation window and 

the Job Management screen (‘Job Overview’ on page 70) provides a graphical 

representation of all resource allocations the system.

The tab is initially blank. To display resource allocations, select a time range from the 

Search on Resources Working control at the top of the tab and click Search.
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N O T E

The chart does not update automatically as job details are changed. To update the chart, 

you must click Search again. If the Show Resource Overview screen needs refresh warning 

User profile setting is enabled, a warning message alerts you when a job has changed.

The main section of the Resource Overview tab contains two areas:

• An expanding list of all resource allocations matching the filtering criteria is displayed 

on the left. You can select a Show option to list only over-allocated resources, 

available (i.e. not over-allocated) resources or all resources. Click the plus or minus 

boxes next to a resource to expand or collapse the allocations underneath it. Double-

click on a job's name to view the Setup Job Resource Allocation window for that job.

• A chart showing the resource allocations on a calendar display. Resource allocations 

are represented as coloured bars. Over-allocated resources are highlighted in red. 

Double-click on a bar to view the Setup Job Resource Allocation window for the job 

that relates to the bar.

You can drag the divider between these two areas to give more or less room for each.

Navigating the Chart

Use the arrow buttons on the bar at the top of the chart to scroll it left and right

To change the zoom level of the chart, click the  and   buttons on the toolbar, or drag 

the bar at the top of the chart left (zoom in) or right (zoom out).

Click the  button to center the chart on the currently selected resource allocation, and 

expand it to fill the width of the display.

Click the  button to print a copy of the chart as it currently appears on screen
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Activities

The Activities tab is a way of monitoring any tasks or appointments that relate to the job 

you are in. You have the ability to create an activity via the New Activity button on toolbar 

at the top. This works in exactly the same manner as the rest of the system.

You will also find the Activity button appears on the detail tab in the same place. The 

function of this is to simply add an appointment or task for a job, whereas the Resource 

Allocation is more based around resource planning.

For more information about Activities please refer to EXO Business Online Help.

Activities Tab
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Understand the basics of Job Costing

Create a New Job

Create a Project

Create a Sub Job

Create a Duplicate Job

Search for an Existing Job

Assigning and Tracking Resources

Add Activities
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Processing Jobs

In this unit you will learn 
how to process jobs

By the end of this unit, you will be able to:

Enter a Quote/Budget

Enter a Timesheet

Enter Costs

Enter a Purchase Order

Generate an Invoice

Attach and Maintain Document

Add History Notes
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Entering Quote/Budget 
Information

To enter quote/budget information for a job:

1 Select the required job and go to the Quote/Budget tab.

Job Costing Quote Budget Tab

Field Description

Group Select The first column contains a checkbox that allows you to select the 

line as part of a group of lines to perform actions on using the right-

click menu.

Narrative The second column displays the  icon if a narrative has been 

added to the line. Right-click on this field and select Add a 

Narrative to add a new narrative to a line.

A narrative can only be added/edited after the line has been saved, 

using Save or Save & Exit.

Code A product code. Type ? and press TAB to displays a list of products. 

Double-click on the required stock item.

Type.. (full stop) and press TAB for a list of Bills of Material.
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Description A product description. This uses the description of the product as 

entered in the main MYOB EXO Business stock record. It can be 

overwritten here.

Qty The quantity to be supplied. It is 1 by default.

Copy To Which tab this transaction will be copied to if the quote becomes 

an actual job. Select from:

C - Cost

T - Time

P - Purchase

N - None

The total quantity of ‘T’ type transactions is shown on the bottom 

of the quote tab for easy reference. This is updated when the save 

button is pressed

GST No Select the GST number from the predefined list of GST entries.  This 

automatically sets the GST rate.

Cost The cost of the product. This uses the cost as entered in the stock 

records but can be overwritten. 

Sell The selling price of the product. This uses the selling price, as 

attached to the customer. It can be overwritten.

Total Automatically calculated. It cannot be directly overridden.

Markup % This value is automatically calculated and can be overwritten. Enter 

the percentage amount of the new markup, ignoring the % sign, 

e.g. 112.5 for 112.5%.

Status The status of this line.

Date The date of transaction being entered.

Cost Type Enter a Cost Type (‘Set up Job Costing’ on page 16), if types are 

used. Type ? and press TAB to select from the cost types available 

or enter a shortcode if one has been set up.

.

Cost Group Enter a Cost Group (‘Setting Cost Groups’ on page 22), if groups are 

used. Type ? and press TAB to select from cost groups available 

enter a shortcode if one has been set up.

Cost group will auto populate if the cost type is entered first but can 

be overridden.

Disc (%) Discount applied to the selling price of this line.

Gross Margin % Automatically calculated. It cannot be directly overridden.

Supplier Name The preferred supplier for any lines that you will need to ‘order in’ 

for this job. Used when creating purchase orders based on the lines 

that have a ‘copy to’ flag set to ‘P’ on the quote.
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As this tab is an ExoGrid, there are more columns available by right clicking on the column 

header and selecting Select Visible Columns. The columns shown above are shown by 

default.

Additional columns that may be selected include:

From Location The preferred location to draw stock from if this quote becomes a 

job.

Kit No When a kit is added to the job, the lines of the kit are given a kit 

incidence number that is used to hold the lines of the kit together. 

Lines that are not part of a kit have the value -1.

Quote Options This works in conjunction with the Quote Options defined in the 

area above the grid. These are covered in more detail later but 

allow the quote to be split onto sections (e.g. optional upgrades). 

One quote option is created by default ('Default Option')

Analysis Codes Analysis Codes are arbitrary codes that can be assigned to 

transactions, allowing you to group them together in various ways 

for sorting and reporting. They do not perform any function 

themselves; they are simply a customisable way of grouping related 

transactions together.

Labour Allowance This allows a unit labour allowance to be specified associated with a 

product. Labour allowances are distinct from an actual 'time' 

lookup item within the grid and act as a guide. Labour allowance is 

optionally keyed in the labour allowance column and can also be 

defaulted from an extra field on the Stock Item. This is a ‘per unit’ 

labour value so it is multiplied by quantity. 

Total Labour 

Allowance

The sum of labour allowances is also shown at the bottom of the 

screen.

Field Description

Sell Inc GST Sell price including GST.

GST GST value per unit.

GST Total Total line value of GST.

Total Inc GST Line total including GST.

GST Rate The rate of GST.

Length, Width & 

Depth

Allow additional factors to apply to quantity. These default to 1.

Total Qty Used with Length, Width and Breadth, it gives the effective quantity 

when these factors are multiplied by quantity.
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2 Click Save, Save & Exit, or press CTRL + S to commit the changes.

3 Clicking Cancel cancels changes and returns to the search screen.

N O T E

When adding lines, the checkboxes for those lines will not appear until the quote is saved.

N O T E

The Quote Tab does not move any stock to Work In Progress. Sending Items direct to the 

Invoice Tab from the Quote Tab will not result in any stock movement.

Quote Functions

The functions that are available to be performed on quote lines are detailed below.

Toolbar Options

Re-sorting lines  Quote lines can be moved up and down in the order by selecting the line 

then using the  or  buttons on the toolbar. This will be saved and re-presented in this 

order once the order is saved.

Copy  The  button allows lines defined in a separate job to be appended to the 

current job. This is useful where perhaps you have other template jobs defined.

Line Type This is normally zero but this can indicate:

1= Kit header

2=Component

Kit Code Normally blank but this can contain the BOM code of a kit

Line # Line number. This can be edited and used with the ExoGrid sorting 

capabilities (or Clarity reporting) to re-sequence the lines from their 

original entry sequence.

Analysis codes 1 & 

2

Can be used as another coding for posting to the General Ledger.

Showline Contains a Y or N to indicate if the line should appear on an invoice. 

This applies to kit component lines where the component lines may 

be hidden (set on BOM header)

Spread Defaults to Y but can be changed to N. Indicates if the line will be 

taken into account when using the spread function ( ) to alter the 

quote total.

Pref Serial A single serial number may be selected here if the stock item is 

serialised. This pre-assigns the serial to this line of the job. The line 

quantity must be 1.

Schedule Billing schedule number when using progress invoicing.
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N O T E

If you are copying serialised lines from another job, you will be given the option of pre-

assigning serial numbers to them.

Change quote total  The  button can be used to alter the quoted values of lines to sum 

to a specified total. The system prompts for the new total.

Lines are proportionally altered by factoring them on the basis of old total versus new total 

(the difference is spread according to the lines’ original value). If you have some lines 

which you do not wish to be altered by this process then set the value in their Spread 

column to N.

Check for Price Changes  

Click on the  button to check quoted prices against the latest cost and selling prices 

from the stock ledger. A prompt will appear when copying a quote or a job, when 

converting a quote to a job, or manually by pressing the calculator button.

Apply all new unit costs - Applies new cost prices to all lines.

Apply all new sell costs - Applies new sell prices to all lines.

You can also select individual check boxes for the prices that you choose to alter. This will 

be enforced once you click OK.

Spread New Amount

Job Costing Check Quote Prices
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Check Stock Level

The current levels of stock relating to the products on the quotation tab can be checked 

before it is activated as a job by clicking the  button. This may be useful to help decide 

whether the lines need to be set to be purchased or whether it is expected that stock be 

taken from a another location.

Generate Purchase Order(s)  The  button provides a method of creating purchase 

orders for the job. A list of suppliers from which to purchase services or materials is 

created, to allow the items to be ordered ready for this job to be done once it is accepted.

Highlighting the supplier and clicking the Purchase Order button will populate a purchase 

order on the screen ready to be processed. Lines can be added or removed from this 

purchase order, or even a different supplier may be selected if preferred. Each line ordered 

will be stamped with the current Jobcode so that when the goods arrive they will be 

transferred directly to the job as soon as they are costed via the Inwards Goods functions

.

Quote Stock Level

Job Costing Generate PO Supplier
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N O T E

In order for this button to work you must first select the lines that are to be purchased. This 

can be done via either Right Clicking and selecting Mark for Purchase or Selecting P (Ctrl + 

P) in the Copy To Column.

If the product does not have a Supplier set up then the process will ignore that item.

Convert Quote The Convert Quote to Actual Cost and Convert Quote to Invoice options 

allow a job to be activated when a quote is accepted, and to create the necessary stock 

movements into work in progress. 

This function assumes that there is adequate stock available and will push the quantities 

into negative if there isn't. It also has the option of invoicing these Cost transactions 

immediately. 

Quote Options

By default, all lines of a job belong to the DEFAULT OPTION, which is automatically created 

for each job. When quoting, it may also be preferable to include additional lines for 

optional extras or upgrades to the default being quoted.

To create or maintain one or more additional Options:

1 Click on the Setup button. 

2 A search screen of additional Quote Options will be displayed. For a new job where 

additional options have not yet been created, there will be no entries.

3 Click on the  button to create a new quote option. Double-click on an existing 

option to edit it.

Job Costing Quote Option

Job Costing Quote Options Details
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4 Enter a Quote Options Name or make the necessary changes to the existing name.

5 Click on the  button.

For each line on the Quote/Budget tab the Quote Option column can be changed from the 

DEFAULT OPTION.

Selecting or Unselecting a Quote Option in the header panel will include/exclude that 

option from totals at the bottom of the screen.

The Quote Options can also be used in Clarity reporting to provide alternatively quoted 

options within the single job.

Custom Filters

Custom filtering options are available on the Quote/Budget, Timesheets, Costs and Invoice 

tabs of the Job Details window. To create and apply filters, click the Filter drop down 

button:

Any filters that have already been defined are available in the dropdown. You can also 

select None to turn off filtering, or Maintain Filters to create and edit filters on the 

Maintain Filters window:

To edit an existing filter, select it from the Filter dropdown. To create a new filter, click 

New. Filters are edited using the same interface that is currently available when creating 

Contact Lists and searching for Debtors in Advanced Search mode. 

Users can create one or more filtering conditions based on the fields for the relevant table 

(JOBCOST_HDR, JOBCOST_LINES or JOBCOST_TRANSACTIONS).

As users add filtering conditions, the resulting query is displayed at the bottom of the 

window. Users can tick the Manual filter option to edit this query manually; doing so 

disables the filter building controls.

Job Costing Filter
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Click Save after editing a filter to save the changes and apply the filter immediately. The 

icon on the Filter dropdown changes from red to green to indicate that a filter is currently 

applied. You can also apply an existing filter by selecting it from the dropdown and clicking 

Select and Close. Filters are saved separately for each tab, e.g. filters set up on the Costs 

tab will not be available on any other tabs.

Right-click Menu Options
Right-clicking on a quote/budget line will show options relevant to the selected line, such 

as copying specific lines to the Timesheet, Cost, or direct to the Invoice tab. These options 

change depending on the characteristics of the current line.

Some of these are common with the toolbar actions detailed above.

Send line to  For a line which has not been moved to another tab (i.e. the Copy to field is 

set to "N") the system offers:

• Send Line to Cost Page

• Send Line to Timesheet

• Send Line Direct to Invoice

These can be used to send the line to the Costs (‘Entering Costs’ on page 99), Timesheets 

(‘Entering Time Costs’ on page 90) or Invoice (‘Generating Invoices’ on page 108) tabs 

respectively. The first two of these actions are equivalent to selecting "C" or "T" for the 

Copy to field.

Split line  This allows a line that has a quantity > 1 to be split into two lines so that they can 

be acted upon independently. The system will prompt for the quantity to be split-off into 

the new line:

The remainder of the quantity will be left on the original line.

Mark for purchase (CTRL+P)  This is the same action as changing the Copy to field to "P".

Add Narrative (CTRL+N)  This allows a line level narrative to be added to or edited for a 

line. A narrative editing window is opened with blank or previously entered text. Right 

clicking in the text area provides additional options for inserting text:

• Insert Common Phrases works in the same way as for the job header (‘Common 

Phrases’ on page 54).

• Insert Stock Notes copies the content of the Notes tab from the Stock Item 

maintenance screen.

Split Line
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Attach line to kit  At least one kit must exist on the job before this function can be used. 

When selected, a search screen of kit headers on the job appears so that you can select 

which kit the line is to be appended to. The line will be re-sequenced if necessary and 

added as the last line of the kit.

Remove Line (CTRL+DEL)  This deletes the current line from the job.  A confirmation 

request is displayed.

Kit Functions

There are a number of kit functions which may be used when creating a quote.

Check Stock Level  This checks the current levels of stock relating to the requirements of a 

quotation.

Marked Lines

The functions under Marked Lines on the right-click menu operate on the lines which have 

checkboxes selected. All lines can be selected/unselected by clicking the checkbox in the 

column header row. The Marked Lines submenu contains the following options:

Set Markup %  This function prompts for a markup percentage and adjusts the sell prices 

of the selected lines accordingly.

Set Gross margin %  This function prompts for a gross margin percentage and adjusts the 

sell prices of the selected lines accordingly.

Set Cost Types  This function displays a dropdown list from where the user can select a 

cost type to apply to the selected lines.

Set Cost Groups  This function displays a dropdown list from where the user can select a 

cost group to apply to the selected lines.

Send to Cost Page  This function marks the selected lines to Copy to = C to send them to 

the Costs tab.

Send to Timesheet  This function marks the selected lines to Copy to = T to move them to 

the Timesheet tab.

Send Direct to Invoice  This function sends the selected lines directly to the invoice tab.

Generate Billing Schedule  This function is only selectable if the progress/contract billing 

option is active. This is an advanced feature of the Job Costing package. When used, this 

function creates a new progress billing schedule containing the selected lines. A window 

appears for the user to enter a billing code and description for the billing schedule.
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Entering Time Costs

There are two modes of entering the actual time amount on both the Job Management 

and Direct Time Entry (‘Direct Time Entry’ on page 93) windows. 

• Hours Only

• Hours Calculated from Start and End Times

This setting is controlled by the Calculate 'Hours' from 'Start' and 'End' times in timesheet 

entry user-level profile setting (‘Calculate 'Hours' from 'Start' and 'End' times in timesheet 

entry’ on page 40). If this setting is not enabled, the amount of time can be entered 

directly. In this case, the start and end dates and times must be entered, and the amount 

of time is calculated from these. The hours can still be edited and do not have to agree. If 

you want to enter date and end dates and times, then you will need to make these fields 

visible on time entry grids in the appropriate column order.

N O T E

The Start date is the equivalent of Transaction date on the Cost tab (‘Entering Time Costs’ 

on page 90). 

Select the Timesheets tab:

There are various filter checkboxes at the top of the screen:

• Ready to Invoice - transactions are those that have been ‘pushed’ onto the invoice tab 

but have not yet been invoiced. These are also work in progress. You also use the Send 

All To Invoice button to speed up the process.

Job Costing Timesheet Tab
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• Work in Progress - Committed transactions

• Invoiced - List all Invoiced Items originating from the Timesheets tab.Invoiced 

transactions are no longer editable.

• Cancelled - Sent back to Purchases with no cost incurred.

• Written-off - This will move from WIP to Stock Adjustments and be considered a cost 

to the job. It will not be added to the selling price of the job.

• Hide Kit Components - Hides all related kit components.

Only the Work in Progress filter is enabled by default.

Field Description

Group Select The first column contains a checkbox that allows you to select the 

line as part of a group of lines to perform actions on using the right-

click menu.

Narrative The second column displays the  icon if the line has a narrative 

attached. Right-click on this field and select Add a Narrative to add 

a new narrative to a line.

A narrative can only be added/edited after the line has been saved, 

using Save or Save & Exit.

Job Code Allows you see what job the line entry comes from i.e. sub job

Staff Name An employee name. If unknown type ? and press TAB to search for 

the employee. Double-click on the correct name.

Code A code for the type of labour.

Details The description recorded in the stock records will be the default 

entry here. It can be over written with a more detailed description 

of the job.

Cost The cost of the labour. This uses the cost as entered in the stock 

records. It can be overwritten.

Sell The selling price of the labour. This uses the selling price of the 

product as entered in the stock records. It can be overwritten.

Sell In GST The selling price of the labour including GST

Start Date The date the work was started. Enter as ddmmyy e.g. 210800. The 

entry is automatically changed to 21.08.2000.

Start Time The time the work was started. Has to be added via Select Columns

End Date The date the work was completed. Enter as ddmmyy e.g. 210800. 

The entry is automatically changed to 21.08.2000.

End Time The time the work was completed.Has to be added via Select 

Columns
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Hours The number of hours worked. Part hours are entered in decimals 

not minutes e.g. 2½ hours = 2.5 not 2.30. (Automatically calculated 

if start and end times are enabled.)

Total This value is automatically calculated.

GST GST value per unit.

GST Total Total line value of GST.

Total Inc GST Line total including GST

Mark Up % This value is automatically calculated, but can be modified by line - 

this adjusts the selling price accordingly.

A default markup can be applied for direct purchases via the Cost 

Types (‘Set up Job Costing’ on page 16). This can be overwritten but 

deals well with one-off purchases or subcontracted services where 

the cost price and charge-out vary each time.

Status The status of this line. Will be one of:

•  C - Committed. The stock has been committed to Work in 

progress.

•  R - Ready to be invoiced.

•  I - Invoiced. The line can no longer be edited.

•  X - Cancelled line. If the stock item is material it will be taken 

from work-in-progress and returned to the stock count. It will 

add no cost to job and no sell price. Serial numbers will be 

unassigned.

•  W - Writes item off. This will move from WIP to Stock 

Adjustments and be considered a cost to the job. It will not add 

to selling price of the job.

Cost Type Enter a Cost Type (‘Set up Job Costing’ on page 16), if types are 

used. Type ? and press TAB to select from cost types available.

Cost Group Enter a Cost Group (‘Setting Cost Groups’ on page 22), if groups are 

used. Type ? and press TAB to select from cost groups available. 

Cost group will auto populate if the cost type is entered first, but 

can be overridden.

GST No Select the GST number from the predefined list of GST entries. This 

automatically sets the GST rate.

Disc (%) Discount applied to the line.

Gross Margin % Display field only - cannot be used to work-back the selling price on 

this line.

Analysis Code Can be used as another coding for posting to the General Ledger.

Source Ref An optional reference number.
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Saving

Click Save or Save & Exit to save data or Cancel to lose all entries made.

Direct Time Entry
This screen is used to efficiently enter chargeable time spent on jobs, when data entry is 

done for timesheets are provided covering multiple jobs, rather than individual job sheets. 

The Direct Time Entry method is ‘employee-centric’ and is often used when employee or 

resource timesheets are used listing the times for multiple jobs.

Select Transactions > Direct Time Entry from the main Job Costing menu. The following 

screen appears:

Invoice Date Date of last invoice.

Line # Line number. This can be edited and used with the ExoGrid sorting 

capabilities (or Clarity reporting) to re-sequence the lines from their 

original entry sequence

Showline Contains a Y or N to indicate if the line should appear on an invoice. 

This applies to kit component lines where the component lines may 

be hidden (set on BOM header).

Spread Defaults to Y but can be changed to N. Indicates if the line will be 

taken into account when using the spread function  to alter the 

quote total.

Schedule # Billing schedule number when using progress invoicing.

Allowance This allows a unit labour allowance to be specified associated with a 

product.

Job Costing Direct Time Entry
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Field Description

Job Code The job code. Enter ? and press TAB to select the number if 

unknown.

Title The job title. This fills automatically on entry of job code.

Account This fills automatically on entry of job code. You can make this field 

invisible or move it out to the right as you choose.

Staff Name The resource name. Enter ? and press TAB to select the number if 

unknown.

Code The code. Enter ? and press TAB to select the number if unknown.

Details Brief details of work carried out to be typed in.

Start Date The date the work was started. Enter as ddmmyy e.g. 210800. The 

entry is automatically changed to 21.08.2000.

Start Time The start time. Enter two digits for hours and two digits for 

minutes.

End Date The date the work ended. Enter as ddmmyy e.g. 210800. The entry 

is automatically changed to 21.08.2000.

End Time The end time. Enter two digits for hours and two digits for minutes.

Hours The number of hours worked. Part hours are entered in decimals 

not minutes e.g. 2½ hours = 2.5 not 2.30. (Automatically calculated 

if start and end times are enabled).

Cost Enter the hourly rate cost to the business.

Rate Enter the charge rate to the customer.

Total This value is calculated automatically.

Cost Type Enter a Cost Type (‘Setting Cost Types’ on page 23), if types are 

used. Type ? and press TAB to select from cost types available.

Cost Group Enter a Cost Group (‘Setting Cost Groups’ on page 22), if groups are 

used. Type ? and press TAB to select from cost groups available. 

Cost group will auto populate if the cost type is entered first, but 

can be overridden.

Disc (%) Discount applied to the line.

Source Ref An optional reference number.

Batch Code An optional code to group batches of transactions.

Total Cost This value is calculated automatically.
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Check that all the information entered is correct, then click Save to save the data, or 

Cancel loses all entries made.

Toolbar Buttons

Buttons on the toolbar can assist in the data entry:

New Line copies from line above  Toggle the  button on for line duplication. In this 

mode, pressing TAB for a new line will copy the entry in the line immediately above. It can 

then be over written with changes.

Default Date  Defaults to today's date. Click and use the drop down calendar to choose 

another default date.

Job Costing Timesheets
This is optional add-on module designed to offer a single point of entry for employees who 

track time when used in conjunction with MYOB EXO Job Costing and MYOB EXO Employer 

Services via the Timecard data file. Through this module you can record:  

• Chargeable time

• Non-Chargeable time

• Non-productive time

• A variety of user defined Overtime or special rates

• Extra-ordinary allowances and deductions

• Expense claims

• Holidays and sick days

Timesheets are designed to be entered by the employees themselves while connected to 

the EXO Business database and are displayed in a weekly ‘spreadsheet’ view. This allows 

for daily or weekly entry with a weekly review/reconciliation process and a final approval 

process. The information is completely editable up to the point of approval and can be 

saved and recalled as required, when Job transactions are created. Approved timesheet 

information can be used to generate a timecard data file for importing into your payroll 

system.   

Analysis Codes Analysis Codes are arbitrary codes that can be assigned to 

transactions, allowing you to group them together in various ways 

for sorting and reporting. They do not perform any function 

themselves; they are simply a customisable way of grouping related 

transactions together.

Serviceable Units To assign a serviceable unit to a job, enter the code for the 

serviceable unit in this column. Type ? and press TAB to select from 

a list of available serviceable units.
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The application consists of a single program file, Timesheet.exe, but additional database 

tables are required to be added to EXO Job Costing before the program will run 

successfully (these are set up by the Database Update process).

For further information on this module consult the EXO Job Costing Timesheets 

whitepaper.

MYOB EXO Payroll Integration
MYOB EXO Job Costing has the ability to record timesheet data against a specific job. This 

data can then be exported into MYOB EXO Payroll.

Setting up EXO Payroll Integration

In order for the EXO Payroll integration features to be available, the following company-

level profile settings must be configured:

• Integrate timesheets with PayrollEnterprise - this setting must be enabled.

• PayrollEnterprise export location - this must be set to the root directory of the EXO 

Payroll installation, e.g. C:\Payrollv.

• PayrollEnterprise Database Location - this must be set to the database directory of 

the EXO Payroll installation, e.g. C:\Payrollv\DATABASE.

In addition, the FoxPro ODBC driver must be installed on the MYOB EXO Business server. 

The driver is available on the EXO Business ISO Image.

Finally, ensure that all staff members who will have timesheet data recorded against them 

are set up in both the EXO Business and EXO Payroll systems. Ensure all EXO Business staff 

members have their EXO Payroll Employee Code entered into their Employee ID (Payroll) 

property. This property, located on the Authority tab in the Staff > Users section of the EXO 

Business Configuration Assistant, links the staff member to their corresponding employee 

entry in the EXO Payroll system.

Job Costing Timesheets Feature
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Entering Payroll Information

The following additional fields are available on the Timesheets tab (‘Entering Time Costs’ 

on page 90) when payroll integration is enabled:

N O T E

If a timesheet line is set to ‘Ready to Invoice’, its Ready for Payroll property is ticked 

automatically. This property can be unticked manually if necessary.

Exporting Timesheets

The Post TimeSheets to Payroll menu item is available for exporting the timesheet data in 

a format that can then be imported into EXO Payroll. 

This screen displays all timesheet lines whose Ready for Payroll property is ticked. Lines 

can be unticked to remove them from the posting if necessary.

Clicking OK posts all selected timesheet lines to a TimeTrans.csv file in the location 

specified by the PayrollEnterprise export location profile setting. This file can then be 

imported into EXO Payroll using that program's Import Time Transactions function.

Importing Timesheets into EXO Payroll

Timesheet data is imported into EXO Payroll using the existing import functionality.

Select Import Time Transactions from the Pay menu of PayrollEnterprise and the 

timesheet data is automatically imported.

Field Description

Ready For Payroll A tick box indicating that the line item is ready to be posted to EXO 

Payroll. Once the line item has been posted, this property displays 

"P"

Payroll Hours The number of hours to be sent to EXO Payroll. This value defaults 

to the value of the existing Hours column, but it can be changed to 

any value.

Pay Rate The pay rate multiplier that applies to the overall amount, e.g. 

"Ordinary", "Time & Half". The available options are imported from 

EXO Payroll.

Wage Code The wage code that represent's the employee's hourly rate. This 

value defaults to the employee's default Wage Code from EXO 

Payroll, but it can be edited.

Cost Centre The cost centre related to the payroll expense. This value defaults 

to the employee's default cost centre from EXO Payroll, but it can 

be edited.
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N O T E

In order for this menu option to be available, the Import time transactions option on the 

Payroll Setup window must be ticked and the ‘CSV file option must be selected for Format.
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Entering Costs

Select the Costs tab.

Job Costing Cost Tab

Field Description

Group Select The first column contains a checkbox that allows you to select the 

line as part of a group of lines to perform actions on using the right-

click menu.

Narrative The second column displays the  icon if the line has a narrative 

attached. Right-click on this field and select Add a Narrative to add 

a new narrative to a line.

A narrative can only be added/edited after the line has been saved, 

using Save or Save & Exit.

Job Code Allows you see what job the line entry comes from i.e. sub job

Code A product code. Enter ? and press TAB to select the number if 

unknown.

Description A product description. This uses the description of the product as 

entered in the stock records. It can be overwritten.

Quantity The quantity to be supplied. The default is 1.

Cost The cost of the product. This uses the cost as entered in the stock 

records. It can be overwritten.

Sell The selling price of the product. This uses the selling price of the 

product as against the customer. It can be overwritten.
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Status The status of this line. Will be one of:

•  C - Committed. The stock has been committed to Work in 

progress.

•  R - Ready to be invoiced.

•  I - Invoiced. The line can no longer be edited.

•  X - Cancelled line. If the stock item is material it will be taken 

from work-in-progress and returned to the stock count. It will 

add no cost to job and no sell price. Serial numbers will be 

unassigned.

•  W - Writes item off. This will move from WIP to Stock 

Adjustments and be considered a cost to the job. It will not add 

to selling price of the job.

Total This value is automatically calculated.

Date The date cost was incurred.

GST No Select the GST number from the predefined list of GST entries. This 

automatically sets the GST rate.

Disc (%) Discount applied to the selling price of this line.

Mark Up % This value is automatically calculated, but can be edited. On starting 

to type new entry a small screen pops up. Enter the number for the 

new markup, ignoring the % sign e.g. 112.5, click OK to confirm or 

Cancel to return to screen without making a change.

Invoice Date Date of last invoice.

Kit No When a kit is added to the job, the lines of the kit are given a kit 

incidence number that is used to hold the likes of the kit together. 

Lines that are not part of a kit have the value -1.

Line # Line number. This can be edited and used with the ExoGrid sorting 

capabilities 9or Clarity reporting) to re-sequence the lines from 

their original entry sequence.

Source Ref An optional reference number.

Serviceable Unit If the line relates to a serviceable unit, enter the unit's code here.

WIP Out Date Date of when it moved out of WIP

Labour Allowance This allows a unit labour allowance to be specified associated with a 

product.

Total Labour 

Allowance

This is the extended labour allowance and cannot be edited.

Cost Type Enter a Cost Type (‘Set up Job Costing’ on page 16), if types are 

used. Type ? and press TAB to select from cost types available.
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As this tab is an ExoGrid there are more columns available by right clicking on the column 

header and using Select Visible Columns. The columns shown above are shown by default.

Additional columns that may be selected include: 

Click Save to save the data, or Cancel loses all entries made.

Toolbar Options

Send all to Invoice  Send all lines to the Invoice tab (‘Generating Invoices’ on page 108).

Cost Group Enter a Cost Group (‘Setting Cost Groups’ on page 22), if groups are 

used. Type ? and press TAB to select from cost groups available. 

Cost group will auto populate if the cost type is entered first, but 

can be overridden.

Field Description

Sell Inc GST Sell price including GST.

From Loc Enter a number indicating the From location or type ? and press 

TAB to search for location and double-click to select.

To Loc WIP is locked. No entry can be made in this screen.

Total Cost This value is automatically calculated.

GST GST value per unit.

GST Total Total line value of GST.

Total Inc GST Line total including GST

Staff Name An employee name. If unknown type ? and press TAB to search for 

the employee. Double-click on the correct name.

Length, Width & 

Depth

Allow additional factors to apply to quantity. These default to 1

Total Quantity Used with Length, Width and Breadth gives the effective quantity 

when these factors are multiplied by quantity.

Analysis Codes Can be used as another coding for posting to the General Ledger.

Total Quantity Used with Length, Width and Breadth gives the effective quantity 

when these factors are multiplied by quantity.

Showline Contains a Y or N to indicate if the line should appear on an invoice. 

This applies to kit component lines where the component lines may 

be hidden.

Spread Defaults to Y but can be changed to N. Indicates if the line will be 

taken into account when using the spread function  to alter the 

quote total.

Schedule # Billing schedule number when using progress invoicing.
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Re-sorting Lines  Quote lines can be moved up and down in the order by selecting the line 

then using the Up or Down arrows on the toolbar. This will be saved and re-presented in 

this order once the order is saved.

Copy  This button allows lines defined in a separate job to be appended to the current job. 

This is useful where perhaps you have other template jobs defined.

N O T E

If you are copying serialised lines from another job, you will be given the option of pre-

assigning serial numbers to them.

Right-click Menu Options

Right-clicking on a Cost/Timesheets line will show options relevant to line. These options 

change depending on the characteristics of the current line.

Send Line to Invoice/Send All to Invoice  These options allow you to send the selected 

line, or all lines, to the Invoice tab (‘Generating Invoices’ on page 108).

Split Line  This allows a line that has a quantity > 1 to be split into two lines so that they 

can be acted upon independently. The system will prompt for the quantity to be split-off 

into the new line:

The remainder of the quantity will be left on the original line.

Add Narrative (CTRL+N)  This allows a line level narrative to be added to or edited for a 

line. A narrative editing window is opened with blank or previously entered text.

Cancel Line  If the stock item is material it will be taken from work-in-progress and 

returned to the stock count. It will add no cost to the job and no sell price. Serial numbers 

will be unassigned.

Write-off Line  Writes the line item off. This will be considered a cost to the job. It will not 

add to selling price of the job.

Move Line to Another Job  Moves the line item from one job to another. There are some 

constraints on moving lines:

• The stock item for the line must not be serialised item.

• The jobs must have the same currency.

• The source or destination job must not be read-only.

• The line must not be a kit component.

Job Costing Split Line
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When this option is selected, a search window appears, from which the user selects the 

destination job. The changes to both jobs are automatically saved. The source job window 

remains open.

Attach Line to Kit  Adds the line item to a selected kit (Bill of Materials). At least one kit 

must exist on the job before this function can be used.

Send to Invoice - Sends selected lines to the Invoice Tab as Ready To Invoice.

Cancel - Returns selected stock items back into stock.

Write Off - Items are added to the cost of the finished good, however the sell price 

remains to the same.

Direct Material Entry
This screen allows you to input any stock items used in jobs, across multiple jobs at once. 

The Job Management screen (‘Entering Costs’ on page 99) method is used if the cost entry 

is ‘job-centric’. The Direct Material Entry method is ‘materials- or costs-centric’, because 

costs can be allocated against a number of jobs without having to change screens.

N O T E

If you are using Serialised Stock they will not appear in the stock search window due to 

Direct Material Entry not allow assignment of Serial Numbers
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Select Transactions > Direct Material Entry from the main Job Costing menu or Jobs Tab > 

Direct Material Entry in the Business Workflow Menu.

Job Costing Direct Material Entry

Field Description

Job Code The job code. Enter ? and press TAB to select the number if 

unknown.

Title The job title. This fills automatically on entry of job code.

Account This fills automatically on entry of job code. You can make this field 

invisible or move it out to the right as you choose.

Stock Code The Stock Code. Enter ? and press TAB to select the number if 

unknown.

Description A description of the stock. As the description relates to the stock 

code, no entry is required here. You may accept the default entry or 

edit it.

Qty The quantity used.

Cost The cost of a single item. Entering the stock code may have 

generated an entry. However the entry may be over written.

Sell The sale price of a single item. Entering the stock code may have 

generated an entry. However the entry may be over written.
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Check that all the information entered is correct, then click Save to save the data or Cancel 

loses all entries made.

Toolbar Buttons

Buttons on the toolbar can assist in the data entry:

New Line copies from line above  Toggle the  button on for line duplication. In this 

mode, pressing TAB for a new line will copy the entry in the line immediately above. It can 

then be over written with changes.

Clear Grid  Click the  button to clear all information entered on this screen.

Default Date  Defaults to today's date. Click and use the drop down calendar to choose 

another default date.

Markup (%) No entry as it is automatically calculated. This can be overwritten. 

On starting to type new entry a small screen pops up. Enter the 

number for the new markup, ignoring the % sign e.g. 112.5, click 

OK to confirm or Cancel to return to screen without making a 

change.

Total This value is calculated automatically.

Cost Type Enter a Cost Type (‘Set up Job Costing’ on page 16), if types are 

used. Type ? and press TAB to select from cost types available.

Cost Group Enter a Cost Group (‘Setting Cost Groups’ on page 22), if groups are 

used. Type ? and press TAB to select from cost groups available. 

Cost group will auto populate if the cost type is entered first, but 

can be overridden.

GST No Select the GST number from the predefined list of GST entries. This 

automatically sets the GST rate.

Disc (%) Discount applied to the selling price of this line.

Total Quantity Used with Length, Width and Breadth gives the effective quantity 

when these factors are multiplied by quantity.

Source Ref An optional reference number.

Batch Code An optional code to group batches of transactions.

Gross Margin % This value is calculated automatically.

Analysis Codes Analysis Codes are arbitrary codes that can be assigned to 

transactions, allowing you to group them together in various ways 

for sorting and reporting. They do not perform any function 

themselves; they are simply a customisable way of grouping related 

transactions together.

Serviceable Unit To assign a serviceable unit (See Advanced Job Costing guide) to a 

job, enter the code for the serviceable unit in this column. Type ? 

and press TAB to select from a list of available serviceable units.
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Entering Purchase Orders

Select the Purchases tab. The following screen is displayed:

This tab is used for job-specific purchases. To make a general purchase for the business, 

select Transactions > Purchase Orders Screen from the main Job Costing menu.

The purchase order tab is split into four sections. The life cycle of a purchase order runs 

bottom to top.

Right-click menus for each section can be used to:

• View the Purchase Order history - Show history for selected order line

• Receipt Line - Receipt a purchase order by creating an Inwards Goods Receipt.

• Cost Line - Cost a previous receipt and move goods into store.

Job Costing Purchases Tab

Section Description

Invoiced Goods that have been invoiced by the supplier (final costs).

Costed Awaiting 

Invoice

Costed awaiting invoice. The goods are in stock but the suppliers 

invoice is outstanding. Purchase costs may have been estimated.

In Store Costing Shows inwards goods receipts that have not yet been costed. At this 

stage no stock transactions have been written for the receipt 

therefore the goods do not show as being in stock.

Ordered Awaiting 

Delivery

These are outstanding purchase orders.
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Double-clicking a line in all but the top grid will drill to the purchase order screen for that 

line.

Double-clicking a line in the top grid will display the invoice.

Click Save to save the data, or Cancel to lose all entries made.

New Purchase Orders

To enter a new Purchase Order from the Purchases tab, click the Purchase Order button or 

press F8. Alternatively, purchase orders can be generated based on information entered 

into the quote tab for this job.

To enter or edit Purchase Orders from the main Job Costing screen, select Transactions > 

Purchase Orders Screen.

See the MYOB EXO Business online Help for information on creating Purchase Orders and 

its subsequent work flows.

Once the Purchase Order has been Receipted and Costed, the stock item will then appear 

in the costs tab.It will be moved into the WIP location specified on the job.

Purchase Order Maintenance
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Generating Invoices

There several work flows that may be used for invoicing:

• Lines can be flagged as ready for invoice and then invoiced at a later stage.

• Cost lines can be sent directly to the invoice tab for invoicing.

• Optionally, progress billing may be activated and lines sent to a billing schedule 

within the job. Multiple schedules may exist within a job.

Select the Invoice tab. The following screen is displayed:

By default the filters on the Invoice tab are set to show only “Ready for Invoice” lines. The 

lines must be flagged with this status for them to appear.

N O T E

If changes or additions are made in the EXO Business Invoices screen they will not be 

reflected on the job invoice. Ensure everything to be associated with the job is added via 

the Job Costing module.

Job Costing Invoice Tab

Field Description

Group Select The first column contains a checkbox that allows you to select the 

line as part of a group of lines to perform actions on using the right-

click menu.
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Narrative The second column displays the  icon if the line has a narrative 

attached. Right-click on this field and select Add a Narrative to add 

a new narrative to a line.

A narrative can only be added/edited after the line has been saved, 

using Save or Save & Exit.

Job Code Allows you see what job the line entry comes from i.e. sub job

Code

Description

Quantity

Cost

Sell

These values are carried forward to this tab from the tab they were 

created on. However, values can be over-written and any changes 

will be reflected on the original tab.

Total Cost This value is automatically calculated, and updates to reflect any 

changes made in other fields.

Total This value is automatically calculated, and updates to reflect any 

changes made in other fields.

Disc (%) Discount applied to the selling price of this line.

Mark Up This value is automatically calculated, but can be edited. On starting 

to type new entry a small screen pops up. Enter the number for the 

new markup, ignoring the % sign e.g. 112.5, click OK to confirm or 

Cancel to return to screen without making a change.

Status The status of this line. Will be one of:

•  C - Committed. The stock has been committed to Work in 

progress.

•  R - Ready to be invoiced.

•  I - Invoiced. The line can no longer be edited.

•  X - Cancelled line. If the stock item is material it will be taken 

from work-in-progress and returned to the stock count. It will 

add no cost to job and no sell price. Serial numbers will be 

unassigned.

•  W - Writes item off. This will move from WIP to Stock 

Adjustments and be considered a cost to the job. It will not add 

to selling price of the job.

Invoiced Shows previously invoiced amounts.

Start date

Invoice Date

These values are read-only.

GST No

Gross Margin %

Source Ref

Line No

These values are copied from the Quote tab (‘Entering 

Quote/Budget Information’ on page 80).

Batch Code An optional code to group batches of transactions.
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Invoicing the Job
Invoicing the job is the final step. After checking that all entries are correct, click the 

Invoice Job button in the main toolbar.

The system passes the invoice data to the Invoice Entry window, using the pricing 

information from the job.

Click Save to save the data, or Cancel to lose all entries made.

Schedule # Billing schedule number when using progress invoicing.

Supplied Displays either ‘Y’ or ‘N’ to indicate whether the line item has been 

supplied. Can be altered by right-clicking on the line and selecting 

Toggle Supplied Flag.

Analysis Codes Analysis Codes are arbitrary codes that can be assigned to 

transactions, allowing you to group them together in various ways 

for sorting and reporting. They do not perform any function 

themselves; they are simply a customisable way of grouping related 

transactions together.

Job Costing Invoice Entry
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Invoicing Sub Jobs from a Master Job
If the selected job is a master job, the Invoice Job button becomes a drop-down menu 

with three options:

• Invoice Job - This generates an invoice for the master job only.

• Invoice Job with Sub Jobs - This generates a single consolidated invoice for the 

master job and all of its sub jobs.

• Check Alerts - Will warn if any outstanding lines are held up on the linked sub jobs

N O T E

In order for this menu to be available, the Allow invoicing of sub jobs from master jobs 

Company-level profile setting (‘Allow invoicing of sub jobs from master jobs’ on page 35) 

must be enabled.

For sub jobs lines to come through to the Master Job invoice, you must ensure that Allow 

Invoice via Master Job is checked on the corresponding jobs. 

By default this will happen when you raise a sub job. You can also check what jobs can be 

invoiced via the Sub Jobs Tab in the Master Job. From here you can choose whether or not 

to include the sub jobs by simply checking or unchecking the Invoice via Master column 

check box.

Job Costing Invoice Job Options

Job Costing Sub Jobs Tab
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When Invoice Job with Sub Jobs is clicked, a list of all sub jobs is displayed:

Any jobs that cannot be invoiced are highlighted in red. When a highlighted job is selected, 

the reasons why it cannot be invoiced are displayed at the bottom of the window. Also you 

must make sure that any items to be invoiced on the sub jobs have been set to the status 

of Ready To Invoice.

Click Start Process to generate the consolidated invoice. The details of the master job are 

displayed in the header:

The Job Code column indicates which sub job each line applies to.

Changing the Invoice Total Amount

The Change Invoice Total button (  ) can be used to make the invoice total equal what 

the customer is expecting. This will effectively spread the additional markup (or 

markdown) across all of the lines on the invoice, proportionally by value. The advantage of 

this approach is that you get a truer representation of actual profitability by line, than by 

using an additional markup/markdown line on the invoice.

Job Costing Invoice Sub Jobs

Job Costing Invoice Entry BOM
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This feature can also be useful where the Job is to be billed at a contract rate that may be 

in no-way related to the actual sum of transactions being invoiced.

W A R N I N G

On the invoice tab you have an option to Include Sub Job Lines. If this is selected and you 

click Invoice Job with Sub Jobs it will not let you proceed. If you simply hit Invoice Job, 

everything will work as expected.

Batch Invoicing
You can generate invoices for all lines marked ‘Ready to Invoice’ in a single operation, using 

the Batch Job Invoicing function. Run the batch invoicing function by selecting the Batch 

Job Invoicing menu option.

N O T E

If this menu option is not available, you may need to add it at Setup > Menu Designer. If the 

Allow invoicing of sub jobs from master jobs Company-level profile setting (‘Allow invoicing 

of sub jobs from master jobs’ on page 35) is enabled, the option Invoice sub jobs from 

master job is available at the top of the window. 

Ticking this option means that for each master job, a single invoice will be generated for the 

master job and all of its sub jobs. If the option is not ticked, a separate invoice is generated 

for each sub job.

Searching Jobs

The top section of the Batch Job Invoicing window contains the job filters (‘Applying Job 

Filters’ on page 67) available on the Search tab of the Job Management Screen.

Set filters as necessary, then click Search to display all jobs that match the filter options, 

and that have lines that are set to the ‘Ready to Invoice’ status.

If you have Invoice Sub Jobs from Master Job ticked then it bring the lines from the sub 

jobs through to the master job when the invoice is created.

The tick boxes next to each box can be checked or cleared to include or exclude the job 

from the invoicing process.
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Double-clicking on a job displays the individual lines of the job:

Only lines with the status ‘Ready to Invoice’ are displayed. If there are any problems with 

the job that mean it cannot be invoiced, these are displayed at the bottom of the window.

Click the Goto Job button to open the Job Details window to view all information about 

the job.

Click the PreAlloc Serial Nos button to assign serial numbers to the job.

Check or clear the Selected option to include or exclude the job from the invoicing 

process.

Processing Invoices

To begin processing the selected invoices:

Click the Start Process button.

Job Costing Batch Invoicing Detail

Job Costing Batch Invoice Create
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1 Specify the following details:

2 Click the Create Invoices button to proceed.

If you selected ‘Let me apply charges to individual invoices’, the Create Invoices button is 

replaced by a Continue Process button. Click this button to assign freight charges for each 

invoice using the following window.

3 Enter an amount into the Freight column for each listed invoice (or leave the amount 

at $0.00). Once all charges are applied, click the Create Invoices button to proceed.

When the Create Invoices button is clicked, the system generates all invoices, as well as 

assigning serial numbers and updating job statuses where relevant. You are given the 

option of printing some or all of the invoices.

Field Description

Invoice Date Enter the date for all invoices in the batch

Age Select the period that the invoices will be assigned to.

Freight Select how freight charges will be applied. Choose from:

Same charge for all invoices - Enter the amount that will be 

charged to all invoices.

Let me apply charges to individual invoices - The next window will 

let you enter individual amounts for each invoice.

No freight charges.

Update Job Status If you want to change the Job Status (‘Setting Job Statuses’ on 

page 18) of all jobs invoiced in this batch, select a new status here; 

otherwise, select ‘<Don't Update>’.

Only statuses that have the Jobs are complete characteristic ticked 

are available for selection here.

Job Costing Batch Invoice Freight
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Creating Assets from Output Items

The Create Assets from Output Items option pre-populates the Create Stock Item/Asset 

window with the Output Items sub-tab (‘Output Items’ on page 56) of the main job 

details screen. This will be either the single item window if only one item is pre-populated 

or the multiple items window if there is more than one.Creating Assets

Some businesses may have jobs or projects that create products of value that are not 

invoiced directly to the customer, but instead create stock of value that can be sold via 

Debtors Invoicing or Sales Order entry. Other businesses may use Job Costing to track the 

cost of maintaining an asset or may be creating an asset as part of the job. An example of 

this might be a boat builder using labour and materials to create a mould.

The Create Asset button on the toolbar of the Invoice tab (‘Generating Invoices’ on 

page 108) is used to group the individual lines on an invoice into a stock item. The stock 

item must exist first before the lines can be grouped. There are additional choices by 

clicking the small down arrow to the right of the button. The default action is Create Single 

Asset.

N O T E

This feature is useful when the end result is a product to be returned to stock, or when an 

invoice for services is to be sent to a client, but the client does not need the details of the 

amount, only the total amount.

Creating a Single Asset

Click the Create Asset button or select the Create Single Asset option. The Create Stock 

Item/ Asset window appears:

If the stockcode is known enter it. If it is not known, type ?, then press TAB to search for it. 

If it has not been created, click New.

Job Costing Create Asset

Job Costing Create Asset Detail
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See the MYOB EXO Business online Help For more information on stock items and their 

creation.

Creating Multiple Assets

The Create Multiple Assets option allows you to create multiple stock items as assets.

Enter stock codes in the Code column. For each stock item added, the quantity and unit 

cost columns are editable. The OK button is disabled until the sum of the extended costs 

matches the Total cost to distribute at the bottom of the window. This cost is the sum of 

the costs on the main job screen.

Completing and Closing a Job
A job can continue indefinitely and generate any number of invoices. However many 

people choose to ‘close’ a job after an invoice has been generated and all outstanding lines 

have been resolved by having been invoiced, converted into an asset, written-off or 

cancelled as appropriate. There is no COMPLETE status by default. You define one or a 

number of complete statuses of your own naming. A complete status is one that has the 

Jobs are complete option ticked

Job Costing Create Multiple Assets
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Billing Schedule Tab

This tab is used for several processes in Job Costing including Finding Invoices, Raising 

Credit Notes, Progress Billing and Retentions. In this section we will be covering Identifying 

Invoices and Raising Credit note. For information on the other method please consult the 

Job Costing Advanced Manual.

Identifying Invoices
When an invoice is generated it creates a entry in both the Debtors Transaction Tab under 

Maintain Debtors and in the Billing Schedule Tab.

From here you have a few Right Click options to choose from.

• View Invoice - Will let you view the invoice that has already been printed

• Add Narrative - Put additional information relating to the document in question

• Generate Credit Note - Raise a credit note for the Entire Invoice. This means that you 

cannot amend any of the prices or quantity listed.

• Print Invoice - Prints or emails a copy of the invoice highlighted

From this tab as well you can also see how much is outstanding against invoice by looking 

at the Outstanding column.

Credits
When it comes to Credits, if one has been raised it appears in the Billing Schedule tab. You 

have at the time of creation, an option to allocate against the existing invoice via the 

allocations screen.

If you Right Click and pick Select Lines from Credit Note it will transport you to the Invoice 

Tab and show only the lines relating to what you have raised. These can then be either;

• Sent back to Cost / Timesheets to amend the prices for future invoicing. This scenario 

may have occurred due to error in pricing.

Job Costing Billing Schedule Tab
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• Write Off Items

• Cancel Items

• Moved to Another Job

Furthermore you can also create a credit from the Debtors Transaction tab located in 

Maintain Debtors. This is triggered by Right Clicking on the invoice in question and 

selecting Generate Credit for Job Invoice.

Transaction Tab Generate Credit
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Documents

The Documents tab of Job Management window is a continuation of the MYOB EXO 

Business Documentation features. The document manager allows job specifications, 

contracts, drawings, spreadsheets, project files and so on to be stored against a 

job/debtor. See the MYOB EXO Business online Help for instructions on using the 

Document Manager.

The Documents tab toolbar offers a selection of buttons for creating, importing and 

exporting documents:

When importing or creating a file for inclusion in the Document Manager, a window opens 

for the user to enter filing reference information. It also allows the entry to be a filing link 

to a document held separately on disk or to copy the document content into the database 

itself.

Job Costing Document Tab

Button Function

 Document 

Manager

Opens a search screen that allows searching of all documents in the 

database .

 Create Letter Creates a letter (in RTF format) and pre-populates this with the 

customer address etc. On Save, prompts to store it in database.

 Delete 

Document

Deletes the document row currently highlighted in the grid.

 Merge 

Document

Requests a template file for a mail merge and allows creation of a 

mail merged output file.

 Export File Exports the currently highlighted document file (that is stored in 

the database) to be exported to a standalone file on disk.

 Import File Imports a standalone file into the database and creates a document 

manager entry.
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Saving as a link will use minimal additional disk space but saving into the database may 

make retrieval on a WAN easier.

Drag and Drop

One of the features of both the Documents and History tab is the ability to attach emails 

relating to the job. This is perfect for linking related email to jobs ensuring that everyone 

can see the trail of communication centrally.

By dragging from your local Outlook into either Documents or History tabs, it will present 

you with a question of ‘Save E-mail to Documents’. By Selecting Yes, it will attach a copy of 

the email in the documents folder and create a link it accessible via the tab.All 

attachments on the email will be placed there as well.

You may then open the email by double clicking on the line in question. This will in turn 

launch Outlook to show you the email.

It will also adds a History Note with the Subject and Body of text from the email to the 

History Notes tab.
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History Notes

History Notes are another form of documentation against a job. Unlike documents 

(‘Documents’ on page 120) added to the Document Manager, a History Note only 

accommodates plain text and does not support rich text or images.

The preview pane may be completely shown or hidden by clicking the Show Preview 

toolbar button.

The test may be hidden but the message header retained by clicking the  icon in the 

message header band.

Job Costing History Note Tab
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Click the New History Note button to create an entry or double click an existing entry to 

edit.

Profile Settings

The following User-level profiles affect the behaviour of the History Notes tab:

• Allow delete of history notes (Default=True) - Uncheck to prevent deleting of history 

notes.

• Date stamp on History notes can be selected (Default=True) - Uncheck to prevent 

the selection of date-time stamp on history notes, will always default to 'now'.

• History notes can be edited after saving (Default=True) - Uncheck to prevent 

retrospective editing of history notes once they are saved.

Job Costing History Note Detail
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Enter a Quote/Budget

Enter a Timesheet

Enter Costs

Enter a Purchase Order

Generate an Invoice

Raise Credit Notes

Attach and Maintain Document

Add History Notes



© Copyright 2013 MYOB Technology Pty Ltd

 125

Job Costing Reports

In this unit you will learn 
how to identify what 
reports are available in 
Job Costing

By the end of this unit, you will be able to:

Identify and Run In Built Reports

Identify and Run Clarity Library Reports

Identify and Run Clarity Business Forms
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Overview

A number of inbuilt reports exist in the Job Costing module. The Clarity library also 

contains additional reports and users may create additional ones using the Clarity 

designer. Your MYOB EXO Business trained professional will assist you in creating 

customised reports.

The inbuilt reports and standard clarity reports are available under the Reports menu.

N O T E

It may be necessary to edit the Reports menu at Staff > Menus in the EXO Business 

Configuration Assistant to make all of these reports available.
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Job Analysis Tab

The Analysis tab is a dockable widget area that shows a pictorial view of the performance 

analysis of a job. It provides information about the profitability and status of a job and any 

sub jobs, drawn together on one special tab so that it can be restricted to management 

users only. All of this information can be derived from customised widgets that your 

business partner can amend or create new ones for you.

The right and left arrow buttons allow you to switch from job to job.

Using the Save option next the Layouts Drop Down will give you the ability to save the 

widget layout per user and give them options of layouts to pick from. This means 

employees can have more that one layout when analysing.

N O T E

If the job is a sub job and sub jobs are invoiced from their master jobs (See page 111), the 

Debtor Invoices value displays 0.00. Consolidated Debtor Invoices information is available 

on the Analysis tab for the master job.

You also have an optional tab called Dashboard which gives the users extra widget space 

for job related reporting. This can be hidden using the Hide Tabs in Job Management 

Screen profile in EXO Config if not necessary.

Job Costing Analysis Tab
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Inbuilt Reports

All Reports listed below are extra options that can be added via EXO Config as a Dropdown 

Menu item or as a button on the Business Workflow Menu. They are system built 

reporting devices that can’t be customised. If you are looking for customised report then 

you have the choice of Analytic’s Widgets or Clarity Reports.

All inbuilt reports initially display to screen but may then be printed using the  toolbar 

button in the preview.

Job Costing Report
To generate the report, select Reports > Job Costing Report from the main Job Costing 

menu. The system displays a search screen of Job headers. Select the job you want to print 

or preview.

Job Status Report
To generate the report, select Reports > Job Status Report from the main Job Costing 

menu. The following window is displayed:

Select the criteria for the report by using the controls on this window.

Click OK to generate the report or Cancel to cancel the report.

Job Costing Job Status Report
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Work in Progress Report
To generate the report, select Reports > Work In Progress from the main Job Costing 

menu. The following window is displayed:

The list of jobs can be filtered by Job Status or staff member.

When the Auto Refresh option is ticked, changes to the filters are applied instantly. If this 

option is not ticked, you must click Refresh to display the new selection after changing 

filters.

Double-click on a job to see the job details (‘Creating Jobs’ on page 49).

Right-click on a job to view job details or print the Job Costing Report (‘Clarity Business 

Forms’ on page 134).

To print the report, select Print from the File menu.

To save the report, select Save As from the File menu. Type an appropriate name for the 

file and click Save.

Staff Time Report
To generate the report, from the Job Costing Main Menu:

Select Reports > Inbuilt reports > Staff Time Report. The following screen is displayed:

Select the Staff Name from the drop down box (Resource name). This can be a staff 

member or other resource (e.g. plant item) that you have setup.

Job Costing WIP Report

Job Costing Job Resource Report
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Select the start and end dates using the drop down calendars which display.

Click OK. The system will show a list of jobs and the time for the selected resource.

Tip: To display the Job Costing Report for a job double click on the line of the job. The 

report maybe displayed behind the Staff time report. To bring to the front click anywhere 

on any part of the report that is visible 

To print the report, select Print from the File menu.

To save the report, select Save As from the File menu. Type an appropriate name for the 

file and click Save.

Already Invoiced Report
To generate the report, from the Job Costing Main Menu:

Select Reports > Already Invoiced Report. The system will display a search screen of jobs. 

Highlight the job you want to print and click the Select and Close button to display the 

report.

Double-click an invoice line to display the full invoice.

Master Detail Report
To generate the report, select Reports > Master Details Report from the main Job Costing 

menu. The system displays a search screen of Job headers. Highlight the job you wish to 

print and click the Select and Close button to display the report.

Job Costing Resource Time

Job Costing Already Invoiced Report
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Double click the Master Job to be displayed.

Note: If the job selected is not a Master Job the error message ‘No Data Found’ will be 

displayed.

Double click on a job line to display the Job Costing Report for that line.

To print the report, select Print from the File menu.

To save the report, select Save As from the File menu. Type an appropriate name for the 

file and click Save.

Job Costing Master Detail Report
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Clarity Library Reports

Job Analysis (JCTAnalysis.CLR)

This report runs for one job at a time and gives the invoice & job summary as displayed on 

the Analysis tab in the Job management screen. The report also lists the line level markup 

and margin details for the Quote, cost and time tabs.

Job Status Report (JCHStatus.CLR)

This report has lots of run time parameters available like job status, due date range, 

completion date range etc and is similar to the inbuilt report. The jobs are grouped by 

status and each job can be drilled down to view the transaction line details along with a 

summarised markup% and margin% by the line status.

Work in Progress (JCHWIP.CLR)

This report lists work in progress for all jobs. No parameters are required. The user can drill 

down on each job to view the transaction line details.

Labour/Resource Analysis Report (JCTLAbour.CLR)

This is similar to the inbuilt staff time report but can optionally list all staff (resources) in 

one report.

Job with Invoices/Charges (JCTAlreadyInvoiced.CLR)

This is similar to the inbuilt Already Invoiced Report. The report lists all the jobs that have 

been invoiced and the user also has the provision to view the invoice details for the job.

Job with No Invoices/Charges (JCHUninvoicedjobs.CLR)

The report lists all the jobs which have no invoices/charges and gives basic details of the 

jobs like the job code, title, account, job manager, due date, customer order number, 

status, the current WIP amount and the Current WIP time amount. 

Job Transaction Report (JCTTrans.CLR)

This report shows the job at a line detail level and a summary by cost group and cost type. 

Master Detail Report (JCHMaster.CLR)

This report displays totals of estimates, time, materials and invoiced amounts recorded 

against all sub jobs for the selected master job.

Job Costing Report (JCHCost.CLR)

This report can be printed for an individual job or a combination list of job statuses can be 

specified.
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Purchases Listing by Jobs (JCHPurchases.CLR)

The report lists the various purchases that exist per job. The purchases are categorized as 

invoiced, costed awaiting invoice, instore awaiting costing and ordered awaiting delivery.

Job Cost Summary (JCHSummary.CLR)

The report gives summarised information like the time, materials, invoiced value, job 

value, realised profit etc for the selected jobs. 

Job/Quote Comparison report (JCTComparison.CLR)

The report has been developed to give a comparison between the quotes and the actuals. 

It displays the details of quotes and actuals for each job in terms of quantity, cost price and 

selling price. It gives the comparison between quotes and actuals, in terms of percentage 

variance (+/-) , for various cost groups and cost types in each job. It also has a summary at 

the end of the report, which combines data from all the jobs and gives the comparison 

between the quotes and actuals for the various cost groups and cost types.



© Copyright 2013 MYOB Technology Pty Ltd

Set up and Process EXO Job Costing

 134

Clarity Business Forms

Clarity Forms (CLFs) are identified with specific functions within the Job Costing module. 

These are essential business forms that are part of the usual business workflow. In 

contrast, Clarity Reports (CLRs) can be placed on the MYOB EXO Job Costing menu or run 

via the command line.

Each of the main job forms can have a drop down list presenting a variety of formats.

These are known as a ‘form file lists’ and are set up as comma-separated lists in the 

company profiles area of the EXO Business Configurator application. A good example is 

having several different options of quote layout available at printing time, e.g. detailed, 

brief etc.

The following standard CLF files are available in Job Costing:

Invoice.CLF

The default Debtors Invoice form based on the DR_INVLINES and DR_TRANS tables.

Will display ‘Copy’ if it detects that it has been printed previously. Often a job costing user 

will link additional job information to the debtors invoice

JobPreview.CLF

This form appears identical to Invoice.CLF, but the report itself is derived from Job 

Transactions and JOBCOST_HDR, as the DR_INVLINES and DR_TRANS entries have not yet 

been entered. Its purpose is to predict the appearance of the invoice before posting it to 

Debtors, allowing you to make alterations to the job.

JobQuote.CLF

Used to provide a printout of the job in a customer-oriented format.

JobSheet.CLF

Usually used as a sheet including work instructions and contact details for the job.

Other Job Forms

Form file lists allow you to create any number of job related business forms. Business 

examples might include Quality control sheets or a stock picking sheet.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Identify and Run In Built Reports

Identify and Run Clarity Library Reports

Identify and Run Clarity Business Forms
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Frequently Asked 
Questions
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1 Does Job Costing support a FIFO-style stock costing method?

Answer: No, this method is not fully supported.

2 Can I manually type into the Contacts field on the job, rather than setting up a Contact 

on the Debtors account?

Answer: It is not possible to edit the Contacts field on a job header directly, as this is a 

lookup field to the table of Debtor Contacts. You can only add to or pick from the list of 

Contacts. We suggest that you enter text Contact references in the Our ref field, or the 

Notes sub-tab.

3 Why can't I modify a transaction on the Costs or Timesheets tabs once it is ‘Ready to 

Invoice’?

Answer: Once a transaction has been transferred to the Invoice tab (See page 108), all 

alterations must be made to that transaction via the Invoice tab, or the transaction must 

be returned to the source tab by using right-click menu. The transaction is locked for 

editing if its status is ‘R’ - it must be returned the tab of origin before it can be modified.

4 How can I speed up the entry of transactions? 

Answer: Use the default Cost Types (See page 23) by stock item as much as possible, as 

this speeds up entry. Select visible columns and the order of these columns on the 

transactions entry grids with care.

Also you can use Direct Material and Times to decrease entry time via the Paste from 

Clipboard option.

5 Can I post Creditors Invoice lines directly to jobs without using Purchase Orders?

Answer: It is possible to enter lines directly from Creditors Invoices to jobs; however you 

cannot assign Cost Types (See page 23) and Cost Groups (See page 22) at this time. The 

default Cost Type/Group will be assigned based on the stock item defaults.

6 Can I post Inwards Goods receipt lines directly to jobs?

Answer: It is highly recommended that you receipt goods via the Inwards Goods process in 

MYOB EXO Business, as FX and landed costs are taken into account this way. This is a far 

more accurate method than simply receipting stock without any reference to the costs of 

getting the goods into store.

7 Can I use line discounts and special price rules in Job Costing?
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Answer: Yes. Best price rules will apply in Job Costing unless they are disabled via the Best 

price and discounting in Job Costing company-level profile setting (‘Job Costing Company 

Profiles’ on page 35). You can enable or disable the Discount column using the grid column 

controls by right-clicking on the transaction entry grid.

The pricing policy for specific Debtors is applied to PRICE 1-N for the price number that 

customer is associated with. 

8 Can I track stock batches and serial numbers via Job Costing?

Answer: Batch number features are not enabled in Job Costing at present. 

Full pre-assignment of Debtor serial numbers is possible and multiple serial numbers can 

be applied to a single line. Not all serial number types are supported. There are issues with 

Fully Tracked serial numbers, as this places heavy restrictions on the ability to save stock 

transactions on a job before you know what the serial numbers are going to be.

9 Can I have sell prices in Foreign Currency within a Job?

Answer: Yes

10 Can I use the New Purchase Order button on the Purchases tab to create multiple 

Purchase Orders without returning to the Purchases tab after each one?

Answer: If you click the Purchase Order button on the Purchases tab (See page 106), this 

will automatically lock the job code in to the reference field as the default job code for 

each line. If you save this order and click New from the Purchase Order search screen, the 

job reference will be locked, but the job code will not be passed into it as default. Our 

recommendation is to use Purchase Orders off the main menu and enter the job code - or 

always go back to the job and click the Purchase Order button if you want to create 

multiple Purchase Orders for a job.

11 Why do I keep getting the wrong job resource when I enter the initials on the 

timesheet?

Answer: If you have two initials defined in the resource table that are the same, the 

system will always pick the first.

12 How do I avoid variances in the Creditors Invoice cost after I have receipted stock onto a 

job?



© Copyright 2013 MYOB Technology Pty Ltd

Set up and Process EXO Job Costing

 140

Answer: This problem should not occur if the Inwards Goods process is followed correctly, 

because the stock is not posted to the job until after it has been formally costed.

13 I have a written a report, and have found a lot of meaningless transactions on a Job 0 

that I don't have. How did these get there and how do I clean them out?

Answer: Previous versions of Job Costing posted all non-job-related Purchase Order lines 

to a non-existent Job 0. These lines were lines that were not posted to jobs. While they do 

not affect the system normally, they may appear as phantom lines in custom reports. 

These can be removed by executing the SQL scripts:

DELETE from JOBCOST_LINES WHERE JOBNO = 0

DELETE from JOB_TRANSACTIONS WHERE JOBNO = 0

14 Can I use the One-off Stock Items features in Job Costing?

Answer: One-off Stock Items cannot be created by pressing CTRL+O on job lines. To create 

a One-off Stock Item you must enter ‘?’ and then choose the Copy Item button on the 

search screen.

15 What are the Length, Width, Depth and Quantity fields for?

Answer: These were written in for a specific industry group. The idea is that Length, Width 

Depth and Quantity are all 1 by default and therefore should have no effect unless they are 

enabled by making them visible and typing a quantity other than 1.00 into them. Another 

field, TOTAL_QUANTITY, exists on the job line to hold the sum of these ‘volumetrics’. This is 

a calculated field and cannot be edited by the user. It should be used for all calculations 

and reports. Normally users will only enter values into the Quantity field as this will always 

appear on reports and business documents.

16 Job Costing volumetric measurements can also cater for fixed dimensions on stock 

items.

Answer: If an extra field X_LENGTH is added to the stock item, the Length field in the Job 

Costing transaction will automatically be populated with this value. The default value of 

the extra field should be 1.00.

If an X_WIDTH field is added to the stock item table, the Width field is populated with this 

value on entry. 

If an X_DEPTH field is added to the stock item table, the Depth field is populated with this 

value on entry.
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Examples might include standard stock lengths and widths for sheets of plasterboard or 

roofing irons where the resulting price on the transaction is by total square metre.

17 How can I use the paste to grid functionality in the Quote tab?

Answer: The Quote tab (See page 80) has the ability to accept lines pasted from a 

spreadsheet if the spreadsheet is in a compatible format, i.e. the columns are in the same 

order and values are compatible.

Pasting of advanced kits is supported in a very comprehensive but very specific fashion, 

not as a generic feature.

18 Does MYOB EXO Job Costing integrate with the Outlook appointment calendar as 

standard?

Answer: The feature that allows you to create appointments for job Resources is designed 

and tested for local Outlook XP, 2010 and 2013. It is only available to users of these 

versions of Microsoft Outlook and 365 is not fully supported.

19 I am receiving the following error message saving a timesheet transaction: ‘Hours on a 

timesheet cannot be zero’. What does this mean?

Answer: When you enter a transaction into the timesheet and Job Costing has been 

configured such that you enter the number of time units manually (as opposed to start 

time and end times) then you must enter a value into this field before the transaction can 

be saved.
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